Roche Applied Science

LightCycler Probe Design
Software 2.0

Version 1.0
February 2004
Cat.-No. 04 342 054 001
# Table of Content

## General Comments

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>I. Features of the LightCycler Probe Design Software 2.0</td>
<td>4</td>
</tr>
<tr>
<td>II. About this manual</td>
<td>5</td>
</tr>
<tr>
<td>III. Symbols used in this manual</td>
<td>5</td>
</tr>
</tbody>
</table>

## A Software Setup

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Installing and starting the software</td>
<td>9</td>
</tr>
<tr>
<td>1.1 Hardware and software requirements</td>
<td>9</td>
</tr>
<tr>
<td>1.2 Installing the new software version</td>
<td>10</td>
</tr>
<tr>
<td>2. Overview of windows and menus</td>
<td>13</td>
</tr>
<tr>
<td>2.1 Design tab</td>
<td>14</td>
</tr>
<tr>
<td>2.2 Sequence tab</td>
<td>14</td>
</tr>
<tr>
<td>2.2.1 Edit buttons</td>
<td>14</td>
</tr>
<tr>
<td>2.2.2 Design parameters</td>
<td>15</td>
</tr>
<tr>
<td>2.3 Analysis tab</td>
<td>17</td>
</tr>
<tr>
<td>2.4 Primer Probe Sets tab</td>
<td>18</td>
</tr>
<tr>
<td>2.5 Menus</td>
<td>19</td>
</tr>
<tr>
<td>2.5.1 File menu</td>
<td>19</td>
</tr>
<tr>
<td>2.5.2 Sequence menu</td>
<td>20</td>
</tr>
<tr>
<td>2.5.3 Settings menu</td>
<td>21</td>
</tr>
<tr>
<td>2.5.4 Tools menu</td>
<td>22</td>
</tr>
<tr>
<td>2.5.5 Help menu</td>
<td>22</td>
</tr>
</tbody>
</table>

## B Principles of Primers and Probe Design

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. How primers and probes work in quantification reactions</td>
<td>25</td>
</tr>
<tr>
<td>1.1 HybProbe Probes for quantification</td>
<td>26</td>
</tr>
<tr>
<td>1.1.1 HybProbe Probes</td>
<td>26</td>
</tr>
<tr>
<td>1.2 The role of primers used with SYBR Green I dye</td>
<td>28</td>
</tr>
<tr>
<td>2. How primers and probes work in mutation detection reactions</td>
<td>28</td>
</tr>
<tr>
<td>2.1 Mutation detection formats</td>
<td>29</td>
</tr>
<tr>
<td>2.1.1 SimpleProbe</td>
<td>29</td>
</tr>
<tr>
<td>2.1.2 HybProbe</td>
<td>29</td>
</tr>
<tr>
<td>2.1.3 HybProbe Plus</td>
<td>31</td>
</tr>
<tr>
<td>3. General requirements of good primer and probe design</td>
<td>32</td>
</tr>
<tr>
<td>3.1 Avoid inter- or intra-molecular homologies</td>
<td>32</td>
</tr>
<tr>
<td>3.2 Avoid negative sequence motifs</td>
<td>33</td>
</tr>
<tr>
<td>3.3 Appropriate melting temperature</td>
<td>34</td>
</tr>
<tr>
<td>3.4 Single annealing site</td>
<td>34</td>
</tr>
<tr>
<td>3.5 Other restrictions</td>
<td>35</td>
</tr>
<tr>
<td>4. Additional requirements for designing mutation-detection probes</td>
<td>35</td>
</tr>
</tbody>
</table>
### Table of Content

<table>
<thead>
<tr>
<th>C</th>
<th>Designing Primers and Probes</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Providing a DNA sequence</td>
<td>39</td>
</tr>
<tr>
<td>2.</td>
<td>Specifying reaction conditions</td>
<td>43</td>
</tr>
<tr>
<td>3.</td>
<td>Specifying design parameters</td>
<td>44</td>
</tr>
<tr>
<td>3.1</td>
<td>Choosing the experiment and probe type</td>
<td>44</td>
</tr>
<tr>
<td>3.2</td>
<td>Specifying sequence information for quantification probes or primers only</td>
<td>45</td>
</tr>
<tr>
<td>3.3</td>
<td>Specifying sequence information for mutation detection probes</td>
<td>47</td>
</tr>
<tr>
<td>3.4</td>
<td>Specifying experiment settings</td>
<td>50</td>
</tr>
<tr>
<td>4.</td>
<td>Analyzing and selecting the design region</td>
<td>52</td>
</tr>
<tr>
<td>5.</td>
<td>Viewing and saving results</td>
<td>54</td>
</tr>
<tr>
<td>5.1</td>
<td>How scores are displayed on the Primer Probe Sets tab</td>
<td>56</td>
</tr>
<tr>
<td>5.2</td>
<td>Viewing primers and probes within the sequence fragment</td>
<td>57</td>
</tr>
<tr>
<td>6.</td>
<td>Exporting a design as an XML file</td>
<td>57</td>
</tr>
<tr>
<td>7.</td>
<td>Using existing oligos in a design</td>
<td>58</td>
</tr>
<tr>
<td>8.</td>
<td>Printing windows and reports</td>
<td>60</td>
</tr>
<tr>
<td>9.</td>
<td>Performing a BLAST search</td>
<td>62</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>D</th>
<th>Performing Advanced Tasks</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Analyzing a design for cross-complementarities</td>
<td>65</td>
</tr>
<tr>
<td>1.1</td>
<td>Opening the Cross Comp Tool and setting parameters</td>
<td>65</td>
</tr>
<tr>
<td>1.1.1</td>
<td>Overview of the Cross Comp Tool main window</td>
<td>66</td>
</tr>
<tr>
<td>1.2</td>
<td>Viewing and understanding analysis scores</td>
<td>68</td>
</tr>
<tr>
<td>1.3</td>
<td>Viewing details of cross-complementarities</td>
<td>70</td>
</tr>
<tr>
<td>1.3.1</td>
<td>Viewing all cross-complementarities in one alignment</td>
<td>72</td>
</tr>
<tr>
<td>1.4</td>
<td>Saving, printing, closing, and reopening a cross-complementarity analysis</td>
<td>73</td>
</tr>
<tr>
<td>1.5</td>
<td>Adding, deleting, and changing oligos in an analysis</td>
<td>74</td>
</tr>
<tr>
<td>2.</td>
<td>Designing primers and probes for a multiplex reaction</td>
<td>76</td>
</tr>
<tr>
<td>2.1</td>
<td>Overview of design steps</td>
<td>76</td>
</tr>
<tr>
<td>2.2</td>
<td>Importing sequences</td>
<td>77</td>
</tr>
<tr>
<td>2.3</td>
<td>Specifying design parameters</td>
<td>77</td>
</tr>
<tr>
<td>2.4</td>
<td>Performing the initial multiplex search</td>
<td>78</td>
</tr>
<tr>
<td>2.5</td>
<td>Adding new sequences to an existing multiplex search</td>
<td>78</td>
</tr>
<tr>
<td>2.6</td>
<td>Refining the search</td>
<td>79</td>
</tr>
<tr>
<td>3.</td>
<td>Specifying experiment and reaction settings</td>
<td>79</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Uninstalling LC PDS 2.0 under Windows XP professional</td>
</tr>
<tr>
<td>2.</td>
<td>Optimizing Primer Probe Sets designed with the LightCycler 2.0</td>
</tr>
<tr>
<td>3.</td>
<td>Recommendation for applying asymmetric PCR</td>
</tr>
<tr>
<td>4.</td>
<td>Troubleshooting</td>
</tr>
<tr>
<td>5.</td>
<td>Overview of file formats</td>
</tr>
<tr>
<td>6.</td>
<td>Literature</td>
</tr>
<tr>
<td>7.</td>
<td>Copyright notice and disclaimers</td>
</tr>
<tr>
<td>8.</td>
<td>Trademarks</td>
</tr>
</tbody>
</table>
General Comments

Thank you for choosing the Primer Probe Design Software 2.0 (LC PDS 2.0) from Roche Applied Science. This Software is for general Laboratory use only.

The LightCycler Probe Design Software 2.0, the LightCycler Multiplex DNA Master Hyb-Probe and the LightCycler 2.0 Instrument represent an optimized system for the design and the realization of multiplex applications.

I. Features of the LightCycler Probe Design Software 2.0

The LC PDS 2.0 is designed to find optimized combination of PCR primers and probes for a given DNA sequence and a given type of experiment. Using LC PDS 2.0 you can design the following:

- Primer-probe sets optimized for quantitative PCR
- Primer-probe sets optimized for mutation-detection
- Primer-only sets optimized for quantitative PCR using SYBR Green I
- Primer-only sets optimized for amplicon multiplexing using melting curve analysis
- Primer-probe sets for multiplex amplification reactions
- Primers and/or Probes to use with existing oligonucleotides

After selecting a design you can use the software to:

- Analyze the Primer Probe Sets in detail for cross-complementarities
- Perform a BLAST search on primers designed
- Print a design report
II. About this manual

This manual explains how to use the LightCycler Probe Design Software 2.0 to design optimized primers and probes for a gene sequence of interest. The manual contains the following chapters:

Chapter A Software Setup → Follow the instructions in this chapter to install the software and to learn about the software windows and menus.

Chapter B Principles of Primer and Probe Design → Read this chapter for a summary of factors affecting primer probe design.

Chapter C Designing Primers and Probes → Follow the step-by-step instructions in this chapter to design primers and probes for quantification and mutation detection reactions. The chapter also explains how to perform additional tasks, such as printing a design report and executing a BLAST search.

Chapter D Performing Advanced Tasks → This chapter contains step-by-step instructions for analyzing cross-complementarities in a potential design. Furthermore, features for designing primers and probes for multiplex reactions, and for specifying default software settings are described in this chapter.

III. Symbols used in this manual

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>IMPORTANT NOTE</td>
<td>This symbol is used to bring your attention to an important annotation.</td>
</tr>
<tr>
<td>□</td>
<td>INFORMATION NOTE</td>
<td>Designates a note that provides additional information concerning the current topic or procedure</td>
</tr>
</tbody>
</table>
Software Setup
# Software Setup

<table>
<thead>
<tr>
<th>A</th>
<th>Software Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Installing and starting the software ........................................................................................................ 9</td>
</tr>
<tr>
<td>1.1</td>
<td>Hardware and software requirements ........................................................................................................... 9</td>
</tr>
<tr>
<td>1.2</td>
<td>Installing the new software version ............................................................................................................ 10</td>
</tr>
<tr>
<td>2.</td>
<td>Overview of windows and menus ................................................................................................................. 13</td>
</tr>
<tr>
<td>2.1</td>
<td>Design tab .................................................................................................................................................. 14</td>
</tr>
<tr>
<td>2.2</td>
<td>Sequence tab ................................................................................................................................................ 14</td>
</tr>
<tr>
<td>2.2.1</td>
<td>Edit buttons ................................................................................................................................................ 14</td>
</tr>
<tr>
<td>2.2.2</td>
<td>Design parameters ....................................................................................................................................... 15</td>
</tr>
<tr>
<td>2.3</td>
<td>Analysis tab ................................................................................................................................................ 17</td>
</tr>
<tr>
<td>2.4</td>
<td>Primer Probe Sets tab ................................................................................................................................. 18</td>
</tr>
<tr>
<td>2.5</td>
<td>Menus ......................................................................................................................................................... 19</td>
</tr>
<tr>
<td>2.5.1</td>
<td>File menu .................................................................................................................................................... 19</td>
</tr>
<tr>
<td>2.5.2</td>
<td>Sequence menu .......................................................................................................................................... 20</td>
</tr>
<tr>
<td>2.5.3</td>
<td>Settings menu ............................................................................................................................................. 21</td>
</tr>
<tr>
<td>2.5.4</td>
<td>Tools menu ............................................................................................................................................... 22</td>
</tr>
<tr>
<td>2.5.5</td>
<td>Help menu ............................................................................................................................................... 22</td>
</tr>
</tbody>
</table>
Software Setup

This chapter discusses the following topics:

- Instructions for installing the software
- Software windows and menus

1. Installing and starting the software

Before you install the LC PDS 2.0, make sure your computer meets the hardware and software requirements described below and then uninstall any previous versions.

1.1 Hardware and software requirements

LC PDS 2.0 requires a computer that meets the following minimum requirements:

<table>
<thead>
<tr>
<th></th>
<th>Windows 2000</th>
<th>Win XP professional</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS</td>
<td>Windows 2000</td>
<td>Win XP professional</td>
</tr>
<tr>
<td>CPU</td>
<td>Pentium 4 / 750</td>
<td>Pentium 4 / 900 and higher</td>
</tr>
<tr>
<td>RAM</td>
<td>256 MB and higher (Recommended: 512 MB)</td>
<td>256 MB and higher (Recommended: 512 MB)</td>
</tr>
<tr>
<td>Display</td>
<td>Minimum: 1024 x 768  (Recommended: 1280 x 1024)</td>
<td></td>
</tr>
<tr>
<td>Printer</td>
<td>Compatible with standard Windows print module</td>
<td></td>
</tr>
</tbody>
</table>

A local area network with internet access is required if you want to do BLAST searches directly from the software.
1.2 Installing the new software

1. Insert the new LightCycler Probe Design Software 2.0 CD into the CD-ROM drive. The installation process extracts files then displays a Welcome window.

2. Click Next. Please confirm the license agreement. The Choose Destination Location window opens.
Click **Next** to accept the default location for the software.

---

**Or** —

To install the software in a different location, click **Browse**, find and select a new location, then click **OK**.

The Setup Type window opens, listing the software icons that can be installed. The icons determine the locations from which you can start the software.

The **Desktop Icon** lets you start the software by double-clicking an icon on your desktop.

The **Program Menu Icon** lets you start the software by selecting the software name and icon from the Start | Programs menu.

4 Leave both icons selected (the default), or **deselect** the option you do not want.

5 Click **Next**.

If Acrobat Reader is not found on your computer, you are prompted to install it.

6 Click **Yes** to install Acrobat Reader or **No** to finish the installation without installing Acrobat Reader.

⚠️ You must have Acrobat Reader version 5 or 6 to create design reports.

A message states that the installation is complete.
You are now ready to use the LightCycler Probe Design Software 2.0.

7. Click Finish.

Before using the software, make sure your monitor resolution is set to a minimum of 1024 x 768.

To start the LC PDS 2.0, double-click the LC PDS 2.0 desktop icon, or click Start | Programs | Roche | LightCycler Probe Design Software 2.0 | LightCycler Probe Design Software 2.0.

If this is the first time you have installed LC PDS 2.0, a Default Settings dialog box opens in front of the main LC PDS 2.0 window. The dialog box lets you modify the default experiment type, primer and probe melting temperatures, and other values.

If you want to modify default settings now, see “Specifying experiment and reaction settings,” in Chapter D.

You can reopen the Default Settings dialog box at any time from the Settings menu.

To close the dialog box, click OK, or the X in the upper right corner.
For an overview of the software and its features see the section “Overview of windows and menus” below.

To begin using the software see Chapter C “Designing Primers and Probes”.

2. Overview of windows and menus

This section describes the LC PDS 2.0 windows and menus. Understanding the windows and menus will help you to follow the detailed procedures required to design primers and probes described in Chapter C “Designing Primers and Probes”.

The main LC PDS 2.0 window is shown below, as it looks before a sequence is entered.

The LC PDS 2.0 window consists of a tab labeled Design 1, containing three subtabs labeled Sequence, Analysis, and Primer Probe Sets. The large white area in the Sequence tab will display the sequence you enter or import. At the top of the window is a menu bar.

Each portion of the window is described in more detail in the following sections.
2.1 Design tab

The Design 1 tab is used to design one set of primers and probes for a single sequence. You can add additional Design tabs (Design 2, Design 3, and so on) to design additional sets of primers and probes for the same or for a different sequence. For example, you use multiple Design tabs if you want to design multiple sets of primers and probes for a multiplex reaction.

2.2 Sequence tab

When you first open the software, the Sequence tab includes a large white area into which you can enter or import a DNA sequence. When you import a sequence, the name of the Design tab is changed to the sequence file name. In the following example, Sequence 1 has been imported.

2.2.1 Edit buttons

Three options at the top of the Sequence tab let you control sequence editing:
- **Insert** ➔ lets you enter a new base at the cursor location.
- **Replace** ➔ lets you select and replace a base.
- **Sequence Locked** ➔ locks the sequence so that it cannot be changed. If selected the buttons Insert and Replace get inactive.

Select **Sequence Locked** to prevent accidental changes to the sequence.
2.2.2 Design parameters

The areas on the right side of the Sequence tab let you specify design parameters. There are three areas:

- **Experiment Type** ➔ Specifies the type of primer or probe you want to design.
- **Sequence Information** ➔ Defines the portion of the sequence you want to analyze. The options available here depend on the type of primer or probe you specified in the Experiment Type section.
- **Experiment Settings** ➔ Specifies design constraints, such as the desired amplicon size range or melting temperature of a primer or probe. Experiment settings can also be specified in a Settings dialog box, displayed when you click the Details button. For more information about the Settings dialog box, see “Specifying experiment and reaction default settings,” in Chapter D.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default Value</th>
<th>Allowed Range</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Quantification/Primers</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Primer T&lt;sub&gt;m&lt;/sub&gt;</td>
<td>60°C</td>
<td>60°C</td>
</tr>
<tr>
<td>Probe 1 T&lt;sub&gt;m&lt;/sub&gt;</td>
<td>65°C</td>
<td>65°C</td>
</tr>
<tr>
<td>Probe 2 T&lt;sub&gt;m&lt;/sub&gt;</td>
<td>68°C</td>
<td>68°C</td>
</tr>
<tr>
<td>Min Amplicon Size</td>
<td>150 bp</td>
<td>60 – 2,000 bp</td>
</tr>
<tr>
<td>Max Amplicon Size</td>
<td>300 bp</td>
<td></td>
</tr>
</tbody>
</table>

The default design settings are suitable for the majority of applications. But the parameters of the Experimental Setting may be adapted for optimization purposes or for special applications.
Sequence tab

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Useful Range</th>
<th>Application/Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primer $T_m$</td>
<td>60°C</td>
<td>50 – 70°C</td>
<td>Desired $T_m$ is application-related and depends on the base composition of the target sequence. By changing the desired $T_m$, the length of the primers can be influenced (e.g., a high value of the desired primer $T_m$ for a AT-rich sequence will yield long primers). The optimal annealing temperature for the PCR reaction is likely to be about 5°C lower than the $T_m$ of the primers.</td>
</tr>
<tr>
<td>Probe 1 $T_m$</td>
<td>65°C</td>
<td>5 – 10°C &gt; primer $T_m$ and &lt; 77°C</td>
<td>To ensure strong binding of the probes during annealing and the generation of a strong signal before probe displacement by DNA polymerase, the $T_m$ of probes should be higher than that of the primers. The $T_m$ of the probes must also be higher than the annealing temperature to see a signal during the reaction. To avoid blocking primer extension during elongation the probe $T_m$ should not be above the extension temperature. To monitor the melting of the sensor probe during SNP detection, the anchor probe must have a higher $T_m$ than the sensor probe.</td>
</tr>
<tr>
<td>Probe 2 $T_m$</td>
<td>68°C</td>
<td>3 – 5°C &gt; probe 1 (sensor) $T_m$</td>
<td></td>
</tr>
<tr>
<td>Forward primer concentration</td>
<td>0.5 µM</td>
<td>0.1 – 1.0 µM</td>
<td>Vary primer concentration during optimization. Low primer concentrations will result in lower yields of desired product. High primer concentrations may promote mispriming and accumulation of non-specific products. You may also choose an asymmetric primer ratio which may lead to an improvement of certain reactions (see Chapter Appendix).</td>
</tr>
<tr>
<td>Reverse primer concentration</td>
<td>0.5 µM</td>
<td>0.1 – 1.0 µM</td>
<td></td>
</tr>
<tr>
<td>Probe 1 concentration</td>
<td>0.2 µM</td>
<td>0.1 – 1.0 µM</td>
<td>The concentration of Hybridization Probes may be adjusted to improve the fluorescence signal. Increasing the concentration of both probes results in a better signal-to-noise ratio and a broader region of log-linear fluorescence. The increase in background fluorescence can be reduced by applying asymmetric probe concentrations (e.g., 0.2 µM donor-dye probe : 0.4 µM acceptor dye probe).</td>
</tr>
<tr>
<td>Probe 2 concentration</td>
<td>0.2 µM</td>
<td>0.1 – 1.0 µM</td>
<td></td>
</tr>
</tbody>
</table>

Clicking the Analyze button at the bottom of the tab begins the analysis, using the parameters and settings you defined. The preliminary results are displayed on the Analysis tab.
2.3 Analysis tab

The software analyzes each base in the sequence fragment according to various criteria and displays the results on the Analysis tab. Use this tab to further limit the search area for primers and probes by defining a search region for the set or for primers and probes individually.

Higher numbers on the Y axis indicate more promising sites, lower scores indicate less desirable sites.

The shaded area is the search area. When you proceed with the search, primers and probes will be designed for this region.

The light horizontal line across the length of the graph represents the median value of all the scores. The darker horizontal line across the shaded area represents the median score of that area. Note that the line moves up or down as you drag the shaded area to different locations in the chart.

The three options below the graph allow you to specify the search area in different ways:

- **Extended** → Uses the entire fragment shown on the graph; the shaded area is removed.
- **Set** → (the default) Lets you define the search area for both primers and probes. To define the search region, you can move the shaded area or drag its borders to resize it. You can define the search region by entering values in the Start and End fields.
- **Individual** → Lets you specify separate areas for the primers and probes. The shaded area is replaced by three shaded areas, one for each primer and one for the probes. You move or resize each of the shaded areas individually or define the regions by entering values in the Start and End fields.

The other boxes below the graph indicate the score, the fragment length, and other information for the search region.

Clicking the Single Set Search button causes the software to search the designated area and display the results on the Primer Probe Sets tab.
2.4 Primer Probe Sets tab

The Primer Probe Sets tab displays the results of the primer probe search. The designs generated by the software are displayed in a ranked list.

Selecting a design displays its sequence details directly below the list. Information about the selected design is also displayed in text boxes on the bottom left. Reaction conditions and search parameters are summarized on the right.

After you have made your decision for a specific Primer Probe Set you can analyze it further using the Cross-Complementarity tool. See Chapter D, “Performing Advanced Tasks,” for more information.

To check a selected design against other genomes, you can submit the design to the NCBI BLAST Web site directly from the LightCycler Probe Design Software 2.0. For more information, see “Performing a BLAST search” in Chapter C.
2.5 Menus

At the top of the LightCycler Probe Design Software 2.0 window are menus used to perform standard Windows functions, as well as specialized LC PDS 2.0 functions.

The options on each menu are described below.

2.5.1 File menu

The File menu contains the following options:

- **New, Open, Save, Save As, Page Setup** → These commands function as they do in other Windows programs.
- **Print Window** → Prints an image of the current window.
- **Print Report** → Creates a PDF version of a selected primer probe design and displays it in a preview window. From the preview window you can print the report.
- **Open Report** → Opens a previously saved report.
- **Numbered list of previously saved designs** → Select a design file to reopen it.
- **Exit** → Closes the LightCycler Probe Design Software 2.0.
The Sequence menu contains the following options:

- **Add Empty** ➔ Adds a new Design tab containing three subtabs. Use Add Empty whenever you want to start a new primer probe design search, in addition to the designs you already have open in the window.

- **Clear** ➔ Deletes the sequence from the currently displayed Design tab, but leaves the tab open.

- **Delete** ➔ Closes the currently displayed Design tab.

- **Import** ➔ Allows to import a sequence in common formats, such as GenBank, EMBL and Fasta or from previously saved LC PDS files (*.lpd files created with LCPDS1 or *.spd files created with LCPDS2). After you select a format, the software displays a dialog box you can use to find and import a sequence.

- **Export** ➔ Displays two options: Fasta and To Order. Selecting Fasta exports the sequence in Fasta Format. Selecting To Order lets you save the results as an XML file.
2.5.3 Settings menu

The Settings menu contains the following options:

- **Comments**: Displays any comments associated with the sequence (such as header information of GenBank or EMBL) or displays an empty comments box so you can add comments.

- **Current Settings**: Displays the Settings dialog box. Use the dialog box to specify settings for the current sequence, such as amplicon size and melting temperatures and to specify reaction conditions for the current sequence, such as used buffer, concentrations of oligonucleotides and dNTPs. Some of the options in this dialog box can also be set on the Sequence tab. The options specified in the Current Settings dialog box apply to the current experiment only.

- **Default Settings**: Displays a dialog box similar to the Settings dialog box, but the settings specified here are the defaults for all new designs. Default settings are overridden by settings in the Current Settings dialog box.

  For more information about default settings, see “Specifying experiment and reaction default settings” in Chapter D.

- **Top 50, Limit Sets, Show All Sets**: These options let you specify how many result sets to display. For more information, see “Viewing and saving result sets,” in Chapter C.
2.5.4 Tools menu

The Tools menu contains the following options:

- **Fixed Oligos options** ➔ These two options open the Fixed Oligos tool, used to specify an existing oligo you want to use in the primer probe design. For more information, see “Using existing oligos in a design,” in Chapter C.

- **Cross Comp Tool options** ➔ These three options open the Cross-Complementarities tool, used to analyze a potential design for cross-complementarities between primers and probes. For more information, see “Analyzing a design for cross-complementarities,” in Chapter D.

- **Show Alignment of Current Selection** ➔ This option opens a dialog box containing the DNA sequence being analyzed, with the primer and probe sites displayed in color.

- **BLAST options** ➔ These two options open a dialog box you can use for submitting primers of a selected design to the NCBI BLAST Web site.

- **Multiplex options** ➔ These options are used to perform a multiplex analysis, in which the software searches for primers and probes that are compatible across multiple DNA sequences. For more information, see “Designing primers and probes for a multiplex reaction,” in Chapter D.

2.5.5 Help menu

The Help menu provides access to the software user manual and other information.
Principles of Primer and Probe Design
<table>
<thead>
<tr>
<th></th>
<th>Principles of Primers and Probe Design</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>How primers and probes work in quantification reactions</td>
<td>25</td>
</tr>
<tr>
<td>1.1</td>
<td>HybProbe Probes for quantification</td>
<td>26</td>
</tr>
<tr>
<td>1.1.1</td>
<td>HybProbe Probes</td>
<td>26</td>
</tr>
<tr>
<td>1.2</td>
<td>The role of primers used with SYBR Green I dye</td>
<td>28</td>
</tr>
<tr>
<td>2.</td>
<td>How primers and probes work in mutation detection reactions</td>
<td>28</td>
</tr>
<tr>
<td>2.1</td>
<td>Mutation detection formats</td>
<td>29</td>
</tr>
<tr>
<td>2.1.1</td>
<td>SimpleProbe</td>
<td>29</td>
</tr>
<tr>
<td>2.1.2</td>
<td>HybProbe</td>
<td>29</td>
</tr>
<tr>
<td>2.1.3</td>
<td>HybProbe Plus</td>
<td>31</td>
</tr>
<tr>
<td>3.</td>
<td>General requirements of good primer and probe design</td>
<td>32</td>
</tr>
<tr>
<td>3.1</td>
<td>Avoid inter- or intra-molecular homologies</td>
<td>32</td>
</tr>
<tr>
<td>3.2</td>
<td>Avoid negative sequence motifs</td>
<td>33</td>
</tr>
<tr>
<td>3.3</td>
<td>Appropriate melting temperature</td>
<td>34</td>
</tr>
<tr>
<td>3.4</td>
<td>Single annealing site</td>
<td>34</td>
</tr>
<tr>
<td>3.5</td>
<td>Other restrictions</td>
<td>35</td>
</tr>
<tr>
<td>4.</td>
<td>Additional requirements for designing mutation-detection probes</td>
<td>35</td>
</tr>
</tbody>
</table>
Principles of Primer and Probe Design

Many factors affect the design of primers and probes for a quantification or a mutation detection reaction. This chapter discusses the following topics:

- How primers and probes work in quantification reactions
- How probes work in mutation detection reactions
- Types of probes you can design for quantification or mutation detection reactions
- Key factors affecting the quality of primer and probe designs

Read this chapter if you are new to primer probe design or want to review design basic principles. Understanding the principles of good primer and probe design will help you to make design choices and to evaluate the LC PDS 2.0 design results.

1. How primers and probes work in quantification reactions

In a typical quantification reaction, the reaction mix is first heated in order to separate (denature) the double-stranded target DNA. The temperature is then lowered during the annealing step of PCR. As the temperature is lowered, pairs of dye-labeled probes bind close together on complementary sequences of one of the single DNA strands. This binding, or hybridization, of a probe pair results in an energy transfer between the fluorescent dyes of the two probes. The PCR instrument measures the increase in fluorescence in each reaction during this process. For more information about the energy transfer process, see “HybProbe Probes for quantification,” below.

As the reaction is cooled, primers in the mix bind to the forward and reverse strands of DNA. Taq polymerase incorporates deoxynucleoside triphosphates (dNTPs) into the reaction, causing the dNTPs to bind to the single DNA strands, beginning at the 3' end of the primers. The polymerase and dNTPs continue to extend until the polymerase falls off or the temperature in the reaction is increased, causing the newly synthesized strands of DNA to denature again.

The heating and cooling cycle is repeated multiple times, producing more DNA product with each cycle. As the amount of DNA increases, the amount of fluorescence measured by the PCR instrument increases. The increase in fluorescence, along with a standard curve, can be used to determine the amount of DNA in the samples.

For a quantification reaction, you typically design a primer probe set that includes the following:

- Forward and reverse primers to elongate each of the DNA strands
- A pair of hybridization probes to provide fluorescence

You can also use SYBR Green I dye in place of probes. For more information about probes and about SYBR Green I dye, see the following sections.
1.1 HybProbe Probes for quantification

You can design the following type of probes for a quantification reaction.

1.1.1 HybProbe Probes

HybProbe Probes are two sequence-specific hybridization probes labeled with fluorescent dyes that are designed to bind close together on a single DNA strand.

The detection principle of dual hybridization probes is called fluorescence resonance energy transfer (FRET). FRET involves the transfer of energy from a donor fluorophore on one probe to an acceptor fluorophore on the other. If the donor and the acceptor fluorophore are very close together, excitation of the donor by the blue light (LED) of the machine results in energy transfer to the acceptor, which emits light of a longer wavelength that can be measured. Increasing amounts of fluorescence during a quantification reaction indicate increasing amounts of DNA.

HybProbe Probes must be designed as a pair with each probe labeled with either the donor dye (Fluorescein) or the acceptor dye (either LightCycler Red 610, LightCycler Red 640, LightCycler Red 670 or LightCycler Red 705). Because the FRET process decreases with the sixth power of distance, hybridization probes must be separated by no more than 1 - 5 nucleotides.
The following table illustrates a quantification reaction using HybProbe Probes.

<table>
<thead>
<tr>
<th>Role of primers and HybProbe Probes in a quantification reaction</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A</strong> Denaturation</td>
</tr>
<tr>
<td><strong>B</strong> Annealing</td>
</tr>
<tr>
<td><strong>C</strong> Elongation</td>
</tr>
<tr>
<td><strong>D</strong> Completion</td>
</tr>
</tbody>
</table>
1.2 The role of primers used with SYBR Green I dye

You can use SYBR Green I dye instead of a probe to provide the fluorescence measured by the PCR instrument. Unlike a probe, SYBR Green I dye binds only to double-stranded DNA and therefore binds after the annealing step in the PCR quantification cycle. SYBR Green I dye is not sequence-specific, but instead binds to any double-stranded DNA product.

If you use SYBR Green I dye, you need to design only the primers needed to amplify the DNA of interest. SYBR Green I requires very specific primers, so that the increase in fluorescence indicates the increase in the target DNA and not any DNA products that might be present in the reaction, such as primer dimers or other non-specific products.

The LightCycler Probe Design Software 2.0 includes a primers-only module you can use to design primers for use with SYBR Green I dye.

2. How primers and probes work in mutation detection reactions

If a reaction mix is heated after fluorescent probes have bound to the single DNA strands, the probes separate from the strands, causing a decrease in the measured fluorescence. The result is a downward curve in fluorescence visible on the PCR instrument's fluorescence chart. The curve is referred to as a "melt curve." The shape of the curve and the temperature at which half the probes have melted off the DNA strands (called the melting temperature or T_m) are different for different DNA products.

To detect the presence of a mutation in the target DNA, you can heat the reaction mix after the probes have bound to the DNA and then observe the T_m and the characteristics of the resulting melt curve.

When a labeled probe for the wild type hybridizes to a mutant DNA sequence, the mismatch in base pairing causes a destabilizing effect on the probe, lowering the temperature at which the probe melts off the target sequence. The melting temperature shift (ΔT_m) between a normal allele-probe match and a mutated allele-probe mismatch results in different fluorescence profiles, which indicate the presence of a mutation. The difference in melting temperature depends on the type of mismatch, the mismatch position within the probe sequence, and the base pairs immediately adjacent to the mismatch.

To detect mutations, you must design sequence-specific probes that provide different melting temperatures (approx. 5°C) between the normal probe-allele combination and the mismatched probe-allele combination.
2.1 Mutation detection formats

You can use three probe formats for mutation analysis:
- SimpleProbe
- HybProbe
- HybProbe Plus

2.1.1 SimpleProbe

A SimpleProbe is a sequence-specific hybridization probe that fluoresces when it binds to a single DNA strand. In a mutation detection reaction, if there is a mismatch under the SimpleProbe, the probe melts off at a lower temperature than if the probe is perfectly matched to the sequence. The difference in melting temperature can indicate the presence of the mutation. The SimpleProbe must be designed to fit centric over the mutation site (or sites) and should provide the largest difference in melting temperature between a perfect match and a mismatch. SimpleProbes can be designed either at the 5' or 3' end. For fragments too short for HybProbes, using SimpleProbes might be advantageous.

⚠️ A guanine at or near the dye end is not recommended and is penalized during design scoring.

2.1.2 HybProbe

HybProbes are two sequence-specific oligos labeled with fluorescent dyes that are designed to bind close together on a single DNA strand. The detection principle of dual hybridization probes is called fluorescence resonance energy transfer (FRET). For a description of the FRET process, see “HybProbes for quantification” above.

Like SimpleProbes, HybProbes can be used to detect mutations by melting curve analysis. One probe, called the sensor probe, is designed to bind over one or more mutation sites. The other probe, called the anchor probe, must be separated by no more than one to five nucleotides from the sensor probe. HybProbe Probes must be designed as a pair with each probe labeled with either the donor or the acceptor dye.
When the reaction mix is heated, the probes separate from the target strands, causing an increase in the distance between the two dyes and a consequent decrease in measured fluorescence. If there is a mismatch under the sensor probe, the probe melts off at a lower temperature than if the probe is perfectly matched. The difference in melting temperature between mismatched probe-target combinations and perfectly matched probe-target combinations can indicate the presence of the mutation. For mutation detection, probes should be designed to provide a large difference in melting temperature between perfectly matched probe-target combinations and the mismatched probe-target combination.

The following table illustrates a mutation detection reaction using HybProbe Probes.
2.1.3 **HybProbe Plus**

HybProbe Plus Probes is a set of three hybridization probes that bind to adjacent locations on the single DNA strand. The probes are used for mutation detection when two mutations are close together, but not close enough to be covered by a single probe. Each of the two sensor probes binds over a mutation site, with the anchor probe between them. The two sensor probes are labeled with the acceptor dye, and the anchor probe is labeled on both ends with the donor dye. Because the FRET process decreases with the sixth power of distance, the probes must be separated by no more than one to five nucleotides.

The melting temperature at which the signal decreases can indicate the presence of each of the mutations. Probes should be designed to provide the largest difference in melting temperature between a perfectly matched probe-target combination and the mismatched probe-target combination.

The figure below illustrates HybProbe Plus Probes in a mutation detection reaction.
3. General requirements of good primer and probe design

Optimal primer and probe designs for any reaction must meet the following general requirements:

- Primers contain few or no intra-molecular sequence homologies (self-complementary sequences). Primer-probe sets contain few or no inter-molecular sequence homologies (cross-complementary sequences that cause binding between a probe and a primer).
- The sequences of both the PCR template and the primers and probes contain as few suboptimal motifs as possible.
- The primers and probes have the desired melting temperatures.
- The primers (and to a lesser extent the probes) have a single annealing site on the PCR template and do not have annealing sites elsewhere on the target genome or on genomes of other contaminating organisms.
- The designs meet various other criteria, such as the specified amplicon size, the spacing between FRET partners, and the required gap between primers and probes.

No primer or probe design is likely to meet all of the criteria completely. The software assesses how closely a design meets the criteria, assigns a score to each design, and presents the results in a ranked list.

Each of the general criteria is discussed in more detail in the following sections.

3.1 Avoid inter- or intra-molecular homologies

Primers or probes with intra-molecular homologies (self-complementary sequences) can form secondary structures, such as hairpins, or can cause the primers themselves to extend (and be amplified), instead of amplifying the target DNA.

Primer-probe sets with inter-molecular homologies (complementarities between sequences) can bind to each other, causing unwanted product.

Other undesired homologies include complements between either a primer or probe and the wrong location in the target DNA, genomic DNA or DNA from another organism that might be included in an environmental sample.

After the software presents a list of possible primer and probe designs, you can use the LightCycler Probe Design Software 2.0 Cross-Comp Tool to review each design for cross complementarities, including self-complementarities. For more information about using the tool, see “Analyzing a design for cross-complementarities,” in Chapter D.

To look for binding sites on other genomes you can also submit a design to the NCBI BLAST Web site directly from the Probe Design Software 2.0. For more information about performing a BLAST search, see “Performing a BLAST search” in Chapter C.
3.2 Avoid negative sequence motifs

Sequence motifs that can have a strong negative effect on PCR should be avoided as locations for primers and probes. Sequence motifs with negative effects on PCR are described in the following table.

<table>
<thead>
<tr>
<th>Sequence motif</th>
<th>Description</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct repeats</td>
<td>Sequence motif of four or more nucleotides, repeated two or more times:</td>
<td>Direct repeats generate secondary binding sites for primers and probes. Stable hybridization to secondary binding sites leads to non-specific binding of probes and primers, thus decreasing PCR and mutation detection efficiency. In the worst case, binding of primers to secondary sites allows the generation of multiple amplicons from the same template. Therefore, LC PDS 2.0 selects against sequences with direct repeat elements.</td>
</tr>
<tr>
<td></td>
<td>...CCAGCT...CCAGCT...</td>
<td></td>
</tr>
<tr>
<td>Single nucleotide runs</td>
<td>Sequence of four or more identical nucleotides:</td>
<td>Single nucleotide runs can be treated as a special case of direct repeats. In addition to the effects caused by direct repeats, single nucleotide runs can lead to ambiguous binding (slippage) of oligonucleotides at their target site. Probe sequences containing a single nucleotide run of more than 3 nucleotides at the 3’ end are rejected. A sub-group of single nucleotide runs are concealed runs (...AAACAAA...). The presence of concealed runs is penalized during scoring of selected primer-probe set.</td>
</tr>
<tr>
<td></td>
<td>...AAAAAA...</td>
<td></td>
</tr>
<tr>
<td>Inverted repeats</td>
<td>Sequence motif of four or more nucleotides, capable of creating self-complementary structures (stem loops or hairpins):</td>
<td>Inverted repeats generate competition between inter-molecular hybridization and intra-molecular hybridization, causing inefficient priming and probing of the target sequence. In the worst case, formation of stable stem loops or hairpins in the binding region, or inside the amplicon, can cause failure of the reaction. They may also lead to the amplification of non-specific products. LC PDS 2.0 strongly selects against inverse repeats.</td>
</tr>
<tr>
<td></td>
<td>...GGTAAC...GTTACC...</td>
<td></td>
</tr>
</tbody>
</table>
3.3 Appropriate melting temperature

For HybProbe Probes, it is important that primers and probes do not melt at the same temperature. Follow the guidelines in the table below when specifying melting temperatures for HybProbe Probes.

<table>
<thead>
<tr>
<th>Guideline for HybProbe $T_m$</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Probe $T_m$ should be 5 – 10°C higher than that of the primers</td>
<td>For successful generation of a fluorescence signal, both HybProbe oligonucleotides have to bind simultaneously to the single-stranded target DNA during the annealing phase of PCR. Because primers are elongated by Taq DNA Polymerase immediately after annealing, even at temperatures below 72°C, this could lead to early displacement of the probes by the polymerase or even to prevention of probe binding due to covering of the probe binding site by the newly synthesized DNA strand. Thus, the $T_m$ of probes should be higher than that of the primers to ensure strong binding of probes during annealing and generation of a signal before probe displacement by DNA polymerase.</td>
</tr>
<tr>
<td>Probe binding should not be too stable (avoid a $T_m$ 10 – 20°C higher than primer $T_m$)</td>
<td>Extremely stable probes may interfere with the amplification process by hindering the Taq DNA Polymerase and lowering the sensitivity of the assay.</td>
</tr>
</tbody>
</table>

The software calculates the $T_m$ for the primer and probe designs based on the experimental conditions (concentrations of primers and probes, concentrations of dNTPs, salt composition of the reaction buffer) and matches them as closely as possible to the $T_m$ values you designate in the software.

Thermodynamic analysis is used to match the $T_m$ values of the primers and to pair the primers with the appropriate probes. Selection of the primers and probes is performed by calculating the $T_m$ of the oligonucleotides using the unified nearest neighbor thermodynamics approach (J. SantaLucia, 1998).

Calculating the $T_m$ by thermodynamic analysis is also used to predict the $T_m$ shift between matched and mismatched probes in single-nucleotide polymorphism detection experiments.

3.4 Single annealing site

Optimal primers and probes should have only one annealing site in the sequence template, no annealing sites in the rest of the target genome, and no annealing sites in genomes of other organisms, if the DNA of the other organisms could be included in the reaction (for example, if other organisms could be present in an environmental sample).

Searching for non-target primer binding is especially important when working with mutations in the human genome. If the primers are complementary to other sections of the DNA, amplification of this non-target sequence is possible. Probes containing repetitive sequences may also be a problem, since the probes will produce a fluorescent signal when they hybridize to these repetitive regions. In the human genome, pseudogenes to the gene of interest may bind both primers and probes. Pseudogenes may be quite similar to the target region, however they usually contain mutations not present in the gene. The
The result of amplifying and detecting pseudogenes can be the addition of ‘new’ melt peaks or constant detection of the mutant.

Sequence homology searches provide a quick method of scanning DNA sequences stored in databases against a query sequence. By searching non-target sequences for homology to the primer sequences, all potential targets for the primer set can be discovered. Of particular importance are those sequences that stably bind both the forward and reverse primer in the correct orientation and within amplification range. Probe sequences with homology to non-target regions are important only if the primers can amplify the sequence or the probe has homology to many non-target sites. Primer-probe sets with significant homology to non-target regions should be redesigned to new areas of the target.

The LC PDS 2.0 includes a tool you can use to start a basic BLAST search from within the software.

3.5 Other restrictions

You can specify various additional requirements that constrain the primer probe design, including:

- Fragment length
- Choice of forward or reverse strand for the annealing site
- Amplicon size range
- Dye type and dye end
- Reaction conditions
- Size ranges for primers and probes

4. Additional requirements for designing mutation-detection probes

As the software scores mutation detection probe designs, it considers the following requirements:

- The sensor probe must be located over the mutation site.
- When using HybProbe Probes, the difference in melting temperature between the sensor probe over a mismatch and the sensor probe over a match must be sufficient to detect the mutation.
- The anchor probe must have a $T_m$ that is approx. 5°C higher than the sensor probe to ensure that the sensor probe always melts off first.
- Sensor probes must have mismatch positions at least three base pairs away from the probe end.

Primer probe sets that do not meet these requirements are penalized during the design process.
Designing Primers and Probes
<table>
<thead>
<tr>
<th></th>
<th>Designing Primers and Probes</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Providing a DNA sequence</td>
<td>39</td>
</tr>
<tr>
<td>2</td>
<td>Specifying reaction conditions</td>
<td>43</td>
</tr>
<tr>
<td>3</td>
<td>Specifying design parameters</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>Choosing the experiment and probe type</td>
<td>44</td>
</tr>
<tr>
<td>3.2</td>
<td>Specifying sequence information for quantification probes or primers only</td>
<td>45</td>
</tr>
<tr>
<td>3.3</td>
<td>Specifying sequence information for mutation detection probes</td>
<td>47</td>
</tr>
<tr>
<td>3.4</td>
<td>Specifying experiment settings</td>
<td>50</td>
</tr>
<tr>
<td>4</td>
<td>Analyzing and selecting the design region</td>
<td>52</td>
</tr>
<tr>
<td>5</td>
<td>Viewing and saving results</td>
<td>54</td>
</tr>
<tr>
<td></td>
<td>How scores are displayed on the Primer Probe Sets tab</td>
<td>56</td>
</tr>
<tr>
<td>5.2</td>
<td>Viewing primers and probes within the sequence fragment</td>
<td>57</td>
</tr>
<tr>
<td>6</td>
<td>Exporting a design as an XML file</td>
<td>57</td>
</tr>
<tr>
<td>7</td>
<td>Using existing oligos in a design</td>
<td>58</td>
</tr>
<tr>
<td>8</td>
<td>Printing windows and reports</td>
<td>60</td>
</tr>
<tr>
<td>9</td>
<td>Performing a BLAST search</td>
<td>62</td>
</tr>
</tbody>
</table>
Designing Primers and Probes

To design a primer or probe, follow the general steps below; each step is described in more detail in the following sections:

1. Provide the DNA sequence to be analyzed.
2. Specify reaction conditions.
3. Specify design parameters.
4. Click Analyze to begin the preliminary analysis.
5. After the software performs the preliminary scoring analysis, define the search region for the primer and probe sites.
6. After the software searches the region, review the ranked results.
7. (Optional) Submit selected designs to the NCBI BLAST Web site.
8. (Optional) Print the analysis windows or generate a design report.
9. Save or export the analysis.

For information about advanced procedures, including performing a cross-complementarity analysis or designing primers and probes for multiplex reactions, see Chapter D “Advanced Tasks.”

1. Providing a DNA sequence

To provide the target DNA sequence, you can import a sequence, copy and paste the sequence from another source, or enter the sequence manually. If necessary, you can edit the sequence after it has been entered.

⚠️ The sequence must contain at least 160 bases.

To enter a sequence manually

1. If an empty Design tab is not available, from the Settings menu, select Add Empty.
2. Click in the window of the Sequence tab, then type the sequence. Valid characters are A, C, G, T, U (mRNA), and N (unknown).
To copy and paste a sequence

1. If an empty Design tab is not available, from the Settings menu, select Add Empty.
2. Copy the sequence from another source.
3. Click in the white area of the Sequence tab, then press Ctrl-V to paste the sequence.

To import Sequence Database Files

The two major nucleic acid sequence databases are GenBank and the EMBL Nucleotide Sequence Database. GenBank is an annotated collection of all publicly available DNA sequences and the genetic sequence database of the US National Institute of Health. The EMBL database is used as a similar database, operated by the European Bioinformatics Institute.

Both databases are accessible via the Internet:

- EMBL: http://www.ebi.ac.uk/embl/ (February 2004)

Both databases use their own sequence file format, which are similar in consisting a header, which contains general information, such as keywords, author names, source organism and the actual nucleic acid sequence. The GenBank sequence format can easily be identified by the entry ‘ORIGIN’ at the beginning of the nucleic acid sequence.

Save the search file under a *.txt extension in your ‘Import’ Folder of LC PDS 2.0.
To import a sequence

1. From the **Sequence** menu, select **Import**, then select the sequence source (for example, GenBank).

![Import menu](image1)

2. Find and select the sequence file, then click **Open**.

![Open file dialog](image2)

The sequence is displayed in the Sequence tab. The sequence name, accession number, and Login Name are displayed in the corresponding boxes in the Sequence Information area of the window.

To modify a sequence after it has been entered

1. Deselect the **Sequence Locked** option.

2. Click either **Insert** or **Replace**.

   If Insert is selected, a new character is inserted at the cursor position. If Replace is selected, a new character replaces a selected character.

![Sequence modified](image3)

3. Click the location to insert the new character, or select the character to be replaced.

4. Type the new character.

   Valid characters are A, C, G, T, U (mRNA), and N (unknown).
2. Specifying reaction conditions

Before designing primers and probes, you must specify the reaction conditions.

To specify reaction conditions

1. From the Settings menu, select Current Settings, then select the Reaction Conditions tab.

   The Reaction Conditions tab contains a list of Roche Standard Buffers.

2. To select a Roche Standard buffer for your experiment, select the buffer name from the list, then click OK.

3. To add a new buffer to the list:
   - Click Add, enter information to define the new type, then click OK.
   - To adapt the Mg\textsuperscript{2+} concentration for Roche Buffer, select the existing buffer, click Edit, modify the Mg\textsuperscript{2+} concentration, then click OK. The modified buffer is added to the list, with the same name as the parent type, but with the concentration added to the name.

4. To delete a buffer that you have added, select the buffer name, then click Delete.
   - You cannot delete Roche Standard buffers.
3. Specifying design parameters

To design primers and probes you must provide the following information:

- The experiment and probe type
- The beginning and ending points for the sequence fragment you want to analyze and the location of mutations
- General experiment settings, such as desired amplicon size and primer and probe melting temperatures

3.1 Choosing the experiment and probe type

You can select one of four experiment types:

- **Quantification** ➔ To design primers and probes for amplification reactions.
- **Mutation** ➔ To design primers and probes for melting curve analysis used to detect mutations.
- **Primers Only** ➔ To design primers for amplification reactions that use SYBR Green I dye.
- **Amplicon Multiplexing** ➔ To design primers for melt reactions that use SYBR Green I dye and that use melting temperatures to distinguish different DNA products.

For information about probe and experiment types, see Chapter B, “Principles of Primer and Probe Design.”

You can select the following detection formats:

- **HybProbe** ➔ Two probes that bind close together on the DNA results in a FRET process between the fluorescent dyes of the two probes.
- **SimpleProbe** ➔ A single probe that fluoresces as it binds to the DNA.
- **HybProbe Plus** ➔ (mutation detection only) Two sensor probes that bind over two mutation sites, with an anchor probe between them. Use HybProbe Plus Probes when you want to use the FRET process and the amplicon size is too small for two HybProbe Probe sets.
To choose the experiment and probe type

1. In the Experiment Type area, select Quantification, Mutation, Primers Only, or Amplicon Multiplexing.

2. If you selected Quantification or Mutation, select SimpleProbe, HybProbe or HybProbe Plus (mutation detection only).

### 3.2 Specifying sequence information for quantification probes or primers only

Follow the steps below if you selected Quantification, Primers Only, or Amplicon Multiplexing in the Experiment Type field.

![Sequence Information](image.png)

To specify sequence information

1. You can specify the first nucleotide of your sequence in the **First Position** field. This might be necessary to keep track of same numbering as in published sequences.

2. To specify the sequence fragment to be analyzed, enter the beginning position in the **From** box and the ending position in the **Analyze To** box. You can analyze up to 10,000 base pairs.
Specifying design parameters

Specifying sequence information for quantification probes or primers only

After you enter the beginning and ending point of the sequence fragment:

- The search region of the sequence is displayed in black characters, and the rest of the sequence is displayed in red.

- The Fragment Length box displays the total length of the region specified.

- The GC Content box specifies the percentage of guanine and cytosine in the fragment you specified. GC base pairs are more stable than AT base pairs, therefore if the GC content is low, longer probes are needed for stability.

- The Position box specifies the current location of the cursor in the sequence.

3 If you selected Quantification as the experiment type, click the down arrow in the Probe Strand box, then select the strand you want to design the probes for (Sense or Anti-Sense).

The Sequence Name and Access # boxes display the name and accession number of the sequence, if you imported the sequence. The boxes are empty if you typed or pasted the sequence. The Author box contains your login name.

4 To enter or change the sequence name, accession number, or author name, select the information in the appropriate box, then type the new information.

5 Click Comments to read or edit any comments associated with the sequence.

6 If you want the software to find primers or probes to go with existing oligos, click Fixed Oligos, then enter information for the existing oligos. For more information about using existing oligos, see “Using existing oligos in a design,” in this chapter.

Go to “Specifying experiment settings,” to continue the analysis process.
3.3 Specifying sequence information for mutation detection probes

For mutation detection, a probe must be designed to bind over the mutation site, which constrains the software search areas and probe design. The goal of good probe design for mutation detection is to have difference in melting temperature between the probe/normal-allele match and the probe/mutated-allele mismatch.

You can design SimpleProbe and HybProbe Probes for up to three mutation sites. When you design the probes for multiple mutations, the software follows these rules:

- There must be at least one base between the mutation sites.
- If there are fewer than five bases between two mutation sites, one probe is designed to cover both sites. Each base over a mutation site can be designed to match either the wild type or the mutation.
- If there are between five and nine bases between two mutation sites, you can choose whether to design one probe to cover both mutation sites or to design separate probes for the sites.
- If there are more than nine bases between two mutation sites, two probes are automatically designed, one for each mutation site.
- The mutations must be located at least 50 bases from the beginning or end of the sequence fragment.
- HybProbe Plus is always designed for two mutation sites, with a sensor probe over each site and an anchor probe between.

You can specify whether you want the probe to match the wild type or the mutation and be placed on the sense or the anti-sense strand. Or you can let the software automatically select the combinations.
This section includes two procedures: one to specify sequence information for a single mutation and the other to specify sequence information for multiple mutations.

To specify sequence information for a single mutation

1. (Optional) To renumber the sequence, enter a new number in the First Position field in the Sequence Information area.

2. To specify the general region to be searched, enter the beginning position in the From box and the ending position in the Analyze To box.

   After you enter the beginning and ending point of the region:
   - The search region of the sequence is displayed in black characters, and the rest of the sequence is displayed in red (see “To specify sequence information” in Chapter C).
   - The Fragment Length box displays the total length of the region specified.
   - The GC Content box specifies the percentage of guanine and cytosine in the fragment you specified.
   - The Position box specifies the current location of the cursor in the sequence.

3. Type the position number of the mutation in the first Mutation Position box.
   - Or –
   
   Click in the first Mutation Position box, then double-click the base in the sequence display.

   For mutation detection, the mutations must be located at least 50 bases from the beginning or end of the sequence fragment. Therefore, be sure to specify a fragment that begins at least 50 bases before the first mutation and ends at least 50 bases after the last mutation.

4. In the Mutation Type box, click the down arrow, then select the type of mutation at this site, such as A to C.

5. In the Mutation Match box, select one of the following methods to design the probe:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>auto</td>
<td>The software automatically determines whether the probe is designed to complement the wild type or the mutation and whether the probe covers the sense or anti-sense strand. The probe is designed to use the most destabilizing mismatch.</td>
</tr>
<tr>
<td>wt</td>
<td>The probe is designed to complement the wild type. The software determines whether the probe covers the sense or anti-sense strand.</td>
</tr>
<tr>
<td>mut</td>
<td>The probe is designed to complement the mutation. The software determines whether the probe covers the sense or anti-sense strand.</td>
</tr>
</tbody>
</table>

6. To enter or change the sequence name, accession number, or author name, select the information in the appropriate box, then type the new information.

7. Click Comments to read or edit any comments associated with the sequence.

8. If you want the software to find primers or probes to go with existing oligos, click Fixed Oligos, then enter information for the existing oligos. For more information about using existing Oligos, see “Using existing oligos in a design,” in this chapter.

Go to “Specifying experiment settings,” to continue the analysis process.
To specify sequence information for multiple mutations

1. (Optional) To renumber the sequence, enter a new number in the First Position field in the Sequence Information area.

2. To specify the general region to be searched, enter the beginning position in the From box and the ending position in the Analyze To box.
   After you enter the beginning and ending point of the region:
   - The search region of the sequence is displayed in black characters, and the rest of the sequence is displayed in red.
   - The Fragment Length box displays the total length of the region specified.
   - The GC Content box specifies the percentage of guanine and cytosine in the fragment you specified.
   - The Position box specifies the current location of the cursor in the sequence.

3. Type the position number of each mutation in a Mutation Position box.
   - Or –
   Click in a Mutation Position box, then double-click the base in the sequence display.
   Enter the mutations in the Mutation Position boxes in sequential order, from left to right. For example, if there are three mutations located on positions 501 and 520 and 545, the first box should display 501, the second 520 and the third 545.

4. Respond to the messages as follows:
   - If there are fewer than five bases between two mutation sites, a message states that one sensor probe will cover both sites. Click OK to clear the message.
   - If there are between five and nine bases between two mutation sites, a message asks whether you want one sensor probe to cover both mutation sites. Click Yes or No.
     If you click No, two probes will be designed, one for each site.
   - If there are more than nine bases between two mutation sites, two sensor probes will automatically be designed, one for each mutation site. No message is displayed.

5. In each Mutation Type box, click the down arrow, then select the type of mutation at this site, such as A to C.

6. If multiple mutations are covered by separate probes, in the Mutation Match box for each mutation select one of the following methods:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>auto</td>
<td>The software automatically determines whether the probe is designed to complement the wild type or the mutation and whether the probe covers the sense or anti-sense strand. The probe is designed to use the most destabilizing mismatch to allow to distinguish between a probe-allele match and a probe-allele mismatch.</td>
</tr>
<tr>
<td>wt</td>
<td>The probe is designed to complement the wild type.</td>
</tr>
<tr>
<td>mut</td>
<td>The probe is designed to complement the mutation.</td>
</tr>
</tbody>
</table>

The software automatically determines whether the sense or anti-sense strand is used.
3.4 Specifying experiment settings

The Experiment Settings area contains boxes used to specify experiment options, such as amplicon size and desired melting temperatures. The available options vary depending on the type of primers and probes you are designing.

The following illustration shows the Experiment Settings area for a Quantification Hybridization probe design.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>auto</td>
<td>The probe is designed to maximize the difference in melting temperature ($T_m$) between a probe-allele match and a probe-allele mismatch, for all the mutations it covers. The software automatically determines whether the probe is designed to complement the wild type or the mutation and whether the probe covers the sense or anti-sense strand.</td>
</tr>
<tr>
<td>wt sense</td>
<td>The probe is designed to bind to the sense strand and complement the wild type.</td>
</tr>
<tr>
<td>wt anti-sense</td>
<td>The probe is designed to bind to the anti-sense strand and complement the wild type.</td>
</tr>
<tr>
<td>mut sense</td>
<td>The probe is designed to bind to the sense strand and complement the mutation.</td>
</tr>
<tr>
<td>mut anti-sense</td>
<td>The probe is designed to bind to the anti-sense strand and complement the mutation.</td>
</tr>
</tbody>
</table>

If multiple mutations are covered by the same probe, for the first mutation select one of the following methods in the Mutation Match box:

If you did not select “auto” in the previous step, then for each additional mutation covered by the same probe, choose wt (wild type) or mut (mutation). (Auto applies to all mutation sites.)

To enter or change the sequence name, accession number, or author name, select the information in the appropriate box, then type the new information.

Click Comments to read or edit any comments associated with the sequence.

If you want the software to find primers or probes to go with existing oligos, click Fixed Oligos, then enter information for the existing oligos. For more information about using existing oligos, see “Using existing oligos in a design” in this chapter.

Select Sequence Locked to prevent accidental changes to the sequence.

Go to “Specifying experiment settings,” below, to continue the analysis process.
To specify experiment settings

1. Enter the minimum size required for the amplicon in the **Min Amplicon Size** box and the maximum size in the **Max Amplicon Size** box.

2. In the **Primer T<sub>m</sub>** box, enter the desired melting temperature for the primers.

3. In the **Probe T<sub>m</sub>** boxes, enter the desired melting temperature for each probe.
   - The number of **Probe T<sub>m</sub>** boxes depends on the type of probe and whether the probes are being designed for mutation detection or for quantification reactions.

4. In the **Dye Type** field, click the down arrow, then select the dye type for the probe acceptor dye.

5. (SimpleProbe only) In the **Dye End** box, click the down arrow, then select either 5’ or 3’.

![Experiment Settings](image)

Because guanine quenches dye, the software needs to know which end of the probe to assess for the presence of guanine. Probe designs with guanine at or near the dye end are penalized during scoring.

6. To set additional experiment options, click **Details**.
   - The Settings dialog box opens with the Experiment Settings tab active. The tab lets you set additional options, including:
     - The minimum and maximum size of all primers and probes
     - The size of the gap between hybridization probes
     - Primer and probe concentrations
     - Individual melting temperatures for probes used with multiple mutations
   - The example below illustrates the Experiment Settings tab for a HybProbe design.

![Experiment Settings](image)

7. Enter values as needed. When finished, click **OK** to close the Settings dialog box.

8. Click **Analyze** to perform the preliminary analysis of the sequence.
   - The Analysis tab opens. For information about using the Analysis tab, see the next section.
4. Analyzing and selecting the design region

After you click Analyze on the Sequence tab, the software displays the results of a preliminary analysis as a chart on the Analysis tab, as illustrated below. You can specify a region, indicated by a shaded area, that you want to use for the Primer Probe search.

When the Analysis tab is opened, the width of the shaded area is a multiple of the amplicon size designated on the Sequence tab. You can drag the shaded area to any location on the chart or resize it.

For mutation detection probes, a vertical line represents the location of each mutation.
To specify the region to analyze

1. Select one of the following:

   - **Extended ➔** Uses the entire fragment shown on the chart to encompass both the primer and the probe sites. Selecting Extended removes the shaded area.
   - **Set ➔** Lets you specify one area, indicated by the shaded portion, to encompass both the primer and the probe sites.
   - **Individual ➔** Lets you specify areas for the primers and probes separately. Selecting Individual replaces the shaded area with three shaded areas: blue (forward primer), green (probe), and pink (reverse primer).

   ![Diagram of region specification](image)

   - To redisplay the default analysis region and settings, click **Reset**.
   - It is possible to specify one or more predefined oligos, called *fixed oligos*, and then let the software search for other oligos to go with the fixed designs. If you specify fixed oligos, the search regions on the Analysis tab are constrained by the location of the fixed oligos. For more information about using fixed primer and probes, see “Using existing oligos in a design,” in this chapter.

2. If you specify **Set** or **Individual**, move the shaded area or areas to the locations you want to analyze. Move a shaded area in any of these ways:
   - Click the shaded area then drag it to a new location.
   - Click the border of an area, then drag the border to resize the area.
   - Enter starting and ending positions for an area in the coordinate boxes below the graph.

   You can specify only valid positions. For example, if using “Individual,” you must place the primer regions on either side of the probe region. If designing probes for mutation detection, you cannot change the probe region.
Viewing and saving results

3. **Click Single Set Search.**

The software searches for the optimal primer and probe locations in the designated area(s), then displays the ranked results on the Primer Probe Sets tab.

⚠️ If you want to abort the search process before it is finished click **Cancel** during the search process. The LC PDS 2.0 will switch to the Primer Probe Sets screen displaying best primer probe sets (Limit Sets or Top 50 Sets) found up to the moment the search was stopped. A Warning message is displayed under the Result table.

This warning is also printed on the Report.

5. **Viewing and saving results**

The Primer Probe Sets tab displays the results of the final analysis. The designs are displayed in a ranked list.

You can limit the number of result sets displayed. You can also save the analysis to a file so it can be reopened later.

**To view and save results**

1. **Optional** To limit the number of result sets displayed, select one of the following options from the **Settings** menu:
   - **Top 50 sets** ➔ Displays the top 50 results sets. Many of these sets have similar oligos.
   - **Limit sets** ➔ Displays five result sets that provide the greatest diversity of oligos among the best-scoring result sets.

2. To view design details, select a design from the result list.

   The design is displayed below the list and is color-coded as follows:
   - Blue = Primers
   - Green = Probe1
   - Red = Probe2

   For more information, see the next section “How scores are displayed on the Primer Probe Sets tab.”

3. **To save the analysis, select Save from the File menu.**
4. Accept the default file name and location, or enter a new name and choose a new location, then click **Save**.

   ![Save dialog box](image)

   The file is saved with an `.spd` extension. The default file name is the name of the sequence. After you click **Save**, the software appends the date and time to the file name.

5. To save the sequence itself:
   - From the **Sequence** menu, select **Export**.
   - Enter a new file name or keep the existing name.
   - Navigate to a location to save the file, then click **Save**.

   The sequence is saved as a text file (.txt extension).

---

### To reopen a previously saved analysis

1. From the **File** menu, select **Open**.

   ![Open dialog box](image)

2. In the dialog box find and select the `.spd` file for the saved analysis, then click **Open**.

   ![Open dialog box](image)

   Saving the three steps serialized and separately in *.spd files (Sequence, preliminary Analysis and the final Primer Probe Sets analysis) gives you the most flexibility for later changes to individual steps.

   Only the last created design will be stored as an *.spd file while the previous designs will be renamed in the archive folder as *.old files. To reopen those files select the file menu and choose **Open** and select file types *.old.

---

See also the “Overview of File Formats” Table in the Appendix.
5.1 How scores are displayed on the Primer Probe Sets tab

Various criteria are used to score the designs, including the complements within the primer probe set and how close the primers and probes are to the specified melting temperatures. Some combinations are eliminated by default, for example, sets with primer/primer complements on a 3' end.

An example of a Primer Probe Sets tab is shown below.

When you select a design from the result list, the design sequence is displayed below the list and also in the text boxes in the lower left portion of the window.

The reaction conditions and sequence information you specified for the analysis are summarized on the right.

For mutation detection probes, the position of the mutation limits the location of the sensor probe and by default the location of any associated anchor probe. Therefore, mutation detection primer probe sets usually have lower scores than quantification primer probe sets for the same amplicon.
5.2 Viewing primers and probes within the sequence fragment

After you complete an analysis, you can view the primers and probes from a selected design in their proper locations within the DNA sequence fragment.

To view a design within the DNA sequence fragment

1. On the Primer Probe Sets tab, select the design you want to view.

2. From the Tools menu, select Show Alignment of Current Selection.

3. Scroll as necessary until you find the primers and probes in the sequence. Primer sequences are displayed in blue, Probes 1 are displayed in red, and Probes 2 are displayed in green.

4. If necessary, adjust the display as follows:
   - To make the window smaller or larger, click and drag the edge of the window.
   - To see or hide line numbers, select or deselect Show Positions.
   - To make the lines longer or shorter, increase or decrease the value in Bases per Line.

5. To display a different result set without closing the window, click the forward and backward arrows (<<, <, >, >>). The arrows display the first, previous, next, and last result sets from the Primer Probe Sets tab.

6. To close the window, click the X in the upper right corner.

6. Exporting a design as an XML file

You can export an oligo design to an XML “order” file that may be used for direct ordering in the future. Meanwhile please refer to the Custom Probe Ordering section of the Roche Applied Science Web site to use the file to order the sequence.

To export a primer probe design to an order file

1. From the Primer Probe Sets tab, select the design you want to order.

2. From the Sequence menu, select Export, then select To Order.

3. Choose a location to save the exported file.

4. Enter a file name, then click Save.

   The file is saved with an .xml extension.
7. Using existing oligos in a design

The LightCycler Probe Design Software 2.0 provides a “fixed oligos” feature that lets you design primers or probes to go with an existing oligo. The existing or fixed oligos can be either from the LightCycler Probe Design Software 2.0 or from another source. The following procedures explain how to use both types of fixed oligos.

To use a fixed oligo from the LightCycler Probe Design Software 2.0

1. Open the .spd file (or .old file) containing the fixed oligo you want to use (File | Open), or perform the analysis to design a particular oligo you want to use.

2. On the Primer Probe Sets tab, select the fixed oligo design.

3. From the Tools menu, select Fixed Oligos – Import Current Selection.

The Fixed Oligos dialog box opens. Each oligo in the selected design is displayed in the dialog box, with information about the oligo in the boxes on the right.

4. Click Clear under each oligo you do not want to use as a fixed oligo, leaving only those you do want to use.

5. To use the complement of the probes, select Probes on Complement Strand.

6. If needed, adjust the oligos as follows:
   - To shift an oligo to the left or right on the strand, click the < and > buttons under the oligo.
   - To add or delete a base on the left or right end of the oligo, use the + and – buttons under the oligo.

Note that the values in the 5' Position, 3' Position, and Length boxes change as you adjust the oligos.
Designing Primers and Probes

Using existing oligos in a design

7 To delete or edit oligos:
   ▶ To delete all oligos, click **Clear All**.
   ▶ To edit an oligo, click in the oligo, then type or edit bases as needed.

If the edited oligo does not match the strand from which you imported the oligo, a warning message states that the strand does not exist in the sequence.

   ▶ To allow mismatched bases, select **Allow Mismatched Oligos** in the lower left of the dialog box. Mismatched oligos are displayed in red.
   ▶ If there are two mismatches in a row, or if the second base from the end is a mismatch, the software cannot calculate a melting temperature. You must enter a melting temperature manually in the $T_m$ field.

8 To use a sequence on the complement strand that is written from 3’ to 5’, select **Complement Strand Oligos 3’ to 5’**, then enter or paste the 3’ to 5’ sequence.

The software will find the 3’ to 5’ sequence in the order it is written. To reverse the sequence so it reads 5’ to 3’, paste in the 3’ to 5’ sequence, then deselect the option.

9 To see the fixed oligos in color on the **Sequence** tab after you close the dialog box, select **Show Fixed Oligos on Sequence**.

10 When finished, click **OK**.

11 On the **Sequence** tab, analyze the sequence again to generate the oligos that correspond to the fixed oligos you specified.

The software uses the fixed oligo(s) to find optimal matching primers or probes. Note that the Fixed Oligos button on the Sequence tab lists the number of fixed oligos currently being used. In the example below, one fixed oligo is being used.

[1 Fixed Oligo]

On the Analysis tab, you cannot change the region that applies to a fixed oligo.
To design primers or probes using a fixed oligo from another source

1. In the LightCycler Probe Design Software 2.0, import or enter the sequence you want to analyze using the fixed oligos.

2. From the Tools menu select Fixed Oligos, or click Fixed Oligos on the Sequence tab.

   The Fixed Oligos dialog box opens, containing no data.

3. Type or paste in the oligo sequences you want to use.

4. Follow the previous procedure beginning at Step 5 to specify the fixed oligos.

8. Printing windows and reports

You can print any of the windows in the LightCycler Probe Design Software 2.0 if you want to keep a record of design parameters and sequence details.

After you complete an analysis and select a design, you can also generate a report containing the design details, including sequence information, experiment settings, and comments (if any). To display or print a report, you must have Adobe Acrobat Reader version 5 or 6 installed.

To print a LightCycler Probe Design Software 2.0 window

1. Display the window you want to print.

2. Press Ctrl-P.

To print a report of a design

1. Complete the primer probe analysis.

2. On the Primer Probe Sets or Multiplex Sets tab, select the design.
3 From the **File** menu, select **Print Report**. A report settings dialog box opens.

4 Select the following report options as needed, then click **OK**:
   - **Print Set Report** ➔ Places an image of the result sequence at the top of the report, followed by a section containing statistics for each oligo in the set (such as position, length, and GC content).
   - **Print Comments** ➔ Includes the comments associated with the DNA sequence (this option is inactive if there are no comments for the sequence).
   - **Remove Report After Printing** ➔ The report will not be saved after printing.
   - **Ask for File Name** ➔ You will be prompted to provide a name and location to save the report.
   - **Save Report to...** ➔ The report will be saved to the specified default location. (If a report of the same name already exists at this location, this option says “Overwrite report in...” Selecting the option will overwrite the existing report.)

5 If you selected “Ask for File Name” in **Step 4**, browse to a location to save the report, enter a report file name (*.pdf), then click **Save**.

   A “Printing progress” dialog box displays the progress of the report generation.

   (During this process, the report is being printed to an Adobe Acrobat PDF file, not to a printer.)

   The PDF file containing the report opens. The following illustrations show the first and second pages of a typical report.

6 Use the standard PDF controls to display each page of the report.

7 Click **Print** to print the report.

8 (Optional) To save a copy of the report to a different location from the one already specified, from the **File** menu, select **Save As**.

9 Click the X in the upper right corner of the PDF window to close the report.
9. **Performing a BLAST search**

After you have performed an analysis and selected a candidate design, you can check the primers against other genome sequences by performing a BLAST search. You must have Internet access from your computer to perform a BLAST search.

1. Perform an analysis to design the primers and probes.

2. On the Primer Probe Sets or Multiplex Sets tab, select the set you want to use for the BLAST search.

3. From the Tools menu, select **BLAST – Import Current Selection**.

   ![BLAST dialog box](image)

   The BLAST dialog box opens. The Forward Primer and Reverse Primer boxes contain the primer sequences from the selected design.

   The Delimiter box contains characters used to separate the forward and reverse primer sequences. Delimiters are needed because when the sequences are submitted to the NCBI BLAST Web site, the forward and reverse primers are concatenated and the combined string is used in the search. Without delimiters, the search could return a match for the “middle” portion of the combined string, which includes parts of both the forward and reverse primer. The presence of the delimiter characters prevents such a match.

4. In the Delimiters box, leave NN or enter some other delimiter character that is not in either the forward or reverse primer.

5. In the Database box, select a BLAST database.

6. In the Select From box, select organism.

7. Click **OK**.

   The request is sent to the NCBI BLAST Web site. When the request has been received, your Internet browser opens to the NCBI BLAST home page. The page displays results when the search is complete.

8. Note the Request ID so you can retrieve the search results again, or use your browser’s commands to save the results.

Other search options are available on the NCBI BLAST Web site.
Performing Advanced Tasks
## Performing Advanced Tasks

<table>
<thead>
<tr>
<th></th>
<th>Performing Advanced Tasks</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td><strong>Analyzing a design for cross-complementarities</strong></td>
<td>65</td>
</tr>
<tr>
<td>1.1</td>
<td>Opening the Cross Comp Tool and setting parameters</td>
<td>65</td>
</tr>
<tr>
<td>1.1.1</td>
<td>Overview of the Cross Comp Tool main window</td>
<td>66</td>
</tr>
<tr>
<td>1.2</td>
<td>Viewing and understanding analysis scores</td>
<td>68</td>
</tr>
<tr>
<td>1.3</td>
<td>Viewing details of cross-complementarities</td>
<td>70</td>
</tr>
<tr>
<td>1.3.1</td>
<td>Viewing all cross-complementarities in one alignment</td>
<td>72</td>
</tr>
<tr>
<td>1.4</td>
<td>Saving, printing, closing, and reopening a cross-complementarity analysis</td>
<td>73</td>
</tr>
<tr>
<td>1.5</td>
<td>Adding, deleting, and changing oligos in an analysis</td>
<td>74</td>
</tr>
<tr>
<td>2.</td>
<td><strong>Designing primers and probes for a multiplex reaction</strong></td>
<td>76</td>
</tr>
<tr>
<td>2.1</td>
<td>Overview of design steps</td>
<td>76</td>
</tr>
<tr>
<td>2.2</td>
<td>Importing sequences</td>
<td>77</td>
</tr>
<tr>
<td>2.3</td>
<td>Specifying design parameters</td>
<td>77</td>
</tr>
<tr>
<td>2.4</td>
<td>Performing the initial multiplex search</td>
<td>78</td>
</tr>
<tr>
<td>2.5</td>
<td>Adding new sequences to an existing multiplex search</td>
<td>78</td>
</tr>
<tr>
<td>2.6</td>
<td>Refining the search</td>
<td>79</td>
</tr>
<tr>
<td>3.</td>
<td><strong>Specifying experiment and reaction settings</strong></td>
<td>79</td>
</tr>
</tbody>
</table>
Performing Advanced Tasks

This chapter explains how to perform advanced tasks using the LC PDS 2.0, including how to analyze a selected primer probe design for cross-complementarities and how to design primers and probes for multiplex reactions.

1. Analyzing a design for cross-complementarities

You can use the LC PDS 2.0 Cross Comp Tool to view the cross-complementarities (including self-complementarities) between any two oligonucleotides (oligos) in a selected design. The tool displays all the cross-complementarities graphically, so you can see the number, length, and location of the cross-complementarities at a glance. The tool also scores the cross-complementarities according to either the number of cross-complementarities or the stability of the cross-complementarities.

To use the tool, perform the following general steps:

1. Open the tool and import or enter the oligos to analyze.
2. Set analysis parameters and options.

After you set analysis parameters, you can:
- View the scores in the main window.
- View details of the cross-complementarities in the Complementarities window.
- Add, delete, or edit sequences if desired.
- Save the analysis and print windows and reports.

Each procedure is described in detail in this chapter.

1.1 Opening the Cross Comp Tool and setting parameters

This section describes how to open the tool, import a primer probe design from the LC PDS 2.0 Primer Probe Sets tab, and set analysis parameters.

You can add oligos manually to the Cross Comp Tool. For more information, see “Adding, deleting, and changing sequences in an analysis,” below.
To open the Cross Comp Tool, import a design, and set parameters

1. Use LC PDS 2.0 to design primers and probes, then on the Primer Probe Sets tab, double-click the design you want to analyze for cross-complementarities. The Cross Comp Tool opens, containing the primer and probe sequences from the selected design.

2. To view cross-complementarities for a different design from the Primer Probe Sets tab, use the arrows at the bottom of the Cross Comp Tool window:
   - > displays the next design in the result list
   - < displays the previous design in the result list
   - >> displays the last design in the result list
   - << displays the first design in the result list

3. In the Min 3' Length box enter the minimum length of 3' complementarities that you want to be displayed.

4. In the Min All Length box enter the minimum length of any complementarity that you want to be displayed.

5. Select Multi Match to see all complementarities between two oligos that are in the same alignment. For more information about MultiMatch, see “Viewing all cross-complementarities in one alignment,” in this chapter.

6. If you want score values to reflect the strength of the cross-complementarity bonds, leave Show Delta G selected. Deselect Show Delta G to have score values represent the number of cross-complementarities between oligos. For more information about scoring, see “Viewing and understanding analysis scores,” below.

1.1.1 Overview of the Cross Comp Tool main window

The following illustration shows a primer probe design as it appears in the Cross Comp Tool window. The content of the window is described below.
Oligo sequences
The main portion of the window displays the oligos for a particular design twice. The first set of oligos is used to analyze the cross-complementarities with the 3’ ends of the primers. The second set is used to analyze all cross-complementarities within the design. Each set of oligos is numbered 1 – 4.

Information in each oligo row
Each row in each set of oligos also includes the following:
- A row number
- A check box used to include or exclude the oligo from the cross-complementarity analysis
- The name of the primer or probe
- The bases in the oligo
- The melting temperature for the oligo as calculated by the software
- The score assigned to the oligo by the software
- Gray “detail” buttons used to view cross-complementarities in a separate Complementarities window. Detail buttons are explained below.

Text above the buttons states the total number of complementarities between the primers and probes in each set.

Detail buttons
The detail buttons to the right of the oligos act as a matrix that links each oligo on the current row with the oligo indicated by the column number above the button. For example, the button on row 1, column 4 links the Forward primer with Probe 2.

Notice that each row has one fewer detail button than the preceding row. This is because there is only one button for each possible combination of oligos. For example, there is no button under column 1 on row 4 because the same cross-complementarities can be viewed by clicking the button under column 4 on row 1.

Clicking a button displays a Complementarities window that displays the cross-complementarities between the oligo on the current row and the oligo indicated by the column number. For more information, see “Viewing details of cross-complementarities,” later in this chapter.
Analyzing a design for cross-complementarities

Viewing and understanding analysis scores

Menu, buttons, and options

The Cross Comp Tool window includes a File menu you can use to open a previously saved cross-complementarity analysis, to save the current analysis, to print the window or a report, and to reposition the window. For more information about using the File menu, see “Saving, printing, closing, and reopening a cross-complementarity analysis,” later in this chapter.

The window includes buttons used to clear all sequences from the window, and to add, delete, or edit individual sequences. For more information about the buttons, see “Adding, deleting, and changing sequences in an analysis,” later in this chapter.

Other options in the Cross Comp Tool window let you specify analysis parameters.

1.2 Viewing and understanding analysis scores

Oligos are assigned a cross-complementarity score. The total score for an oligo is displayed in the Score column. Scores for each oligo pair are also displayed as numbers on the gray detail buttons.

Scores are only calculated for cross-complementarities of at least the minimum size, as specified in the “Min 3’ Length” box and the “Min All Length” box.

Two scoring methods are available:

- The Delta G method reflects the strength of the cross-complementarity bonds, expressed as a Delta G value. To use this method, select Show Delta G.

- The non-Delta G method reflects the number of cross-complementarities between oligos. To use this method, deselect Show Delta G.

How scores are calculated using Delta G

The Show Delta G option calculates the energy in the bond between cross-complementarities and expresses the bond as a negative number, the Delta G value. A larger negative number means a more stable bond.

When Show Delta G is selected, scores are displayed as follows:

- The Score column for each oligo displays the Delta G value of the strongest cross-complementarity (of at least the minimum size) between this oligo and any other oligo in the analysis. For the first set of oligos in the window, this is the strongest 3’ cross-complementarity. For the second set, this is the strongest cross-complementarity of any kind.

- The gray detail buttons display the Delta G value of the strongest cross-complementarity (of at least the minimum size) between this oligo and the oligo represented by the heading number above the button. For the first set of oligos, this is the strongest 3’ cross-complementarity. For the second set of oligos, this is the strongest cross-complementarity of any kind.
Performing Advanced Tasks

In the example above, there are no 3’ cross-complementarities of the minimum length (4 bases). Therefore, the values in the Score column are 0 for the first set of sequences, and there are no score labels on the detail buttons.

There are 23 total cross-complementarities of all kinds (having a minimum length of 4 bases). The second set of oligos displays the Delta G values for the strongest cross-complementarity in the Score column and also on the detail buttons.

For example, the strongest cross-complementarity between the Forward primer and any other oligo is –3279, as indicated in the value in the Score column on row 1. The strongest bond between the Forward primer and itself is –3278, as indicated by the value on the first detail button on row 1.

How scores are calculated using number of cross-complementarities

If Show Delta G is not selected, the scores reflect the number of cross-complementarities (of the minimum length or greater).

The scores are displayed as follows:

- The Score column for each sequence indicates the total number of cross-complementarities of at least the minimum size between this oligo and all other oligos in the analysis.

- The detail buttons display scores as follows:
  - A single number on a detail button without parentheses indicates the length of the largest cross-complementarity (of at least the minimum size) between this oligo and the oligo referenced by the heading number above the button. It also indicates that there is only one cross-complementarity of this size.
  - A number in parenthesis indicates how many of the largest cross-complementarities there are.
  - No number on a button means there are no cross-complementarities (of at least the minimum size) between this oligo and the other oligo.

The example below shows scores when Show Delta G is not selected.
In the example above, there are no 3’ cross-complementarities of the minimum length (4 bases). Therefore, the values in the Score column are 0 for the first set of sequences, and there are no score labels on the detail buttons.

There are 23 cross-complementarities of all kinds (having a minimum length of 4 bases). The second set of oligos displays scores representing the number of largest cross-complementarities. Looking at Row 1 in the second set of bases in the example above, the scores indicate the following:

- The label on the first button, 4(3), indicates that the largest cross-complementarity between the Forward primer and itself is 4 bases long and there are 3 of them.
- The label on the second button, 4(2), indicates that the largest cross-complementarity between the Forward primer and the Reverse primer is 4 bases long and there are two of them.
- The label on the third button, 4, indicates that the largest cross-complementarity between the Forward primer and Probe 1 is 4 bases long and there is one of them.
- The label on the fourth button, 4(2), indicates that the largest cross-complementarity between the Forward primer and Probe 2 is 4 bases long and there are two of them.
- The value in the Score column is 8, indicating that there are a total of 8 cross-complementarities (of at least 4 bases) between the Forward primer and all the other oligos.

The labels on the detail buttons refer only to the largest cross-complementarity between two oligos. A large cross-complementarity includes multiple smaller cross-complementarities. For example, a 5-base cross-complementarity includes two 4-base complementarities. The large and small cross-complementarities are all included in the total score displayed in the Score column.

### 1.3 Viewing details of cross-complementarities

Clicking a detail button opens a Complementarities window that graphically displays the cross-complementarities between the two oligos represented by the button. You can select more than one detail button at a time.
To display the Complementarities window, use any of the following procedures:

- To view complementarities for two oligos, click the detail button that represents the pair of oligos you want to analyze.
- To compare more than two oligos, hold down the Control key, then click the detail buttons for all the oligo pairs you want to see. All combinations of the selected oligos are displayed in the Complementarities window.
- To see all primer-primer combinations, press Shift + Control and click any primer-primer button (for example, Row 1, Column 1).
- To see all primer probe combinations, press Shift + Control and click any primer probe button (for example, Row 1, Column 3);
- To see all probe-probe combinations, press Shift + Control and click any probe-probe button (for example, Row 3, Column 3).

The following illustration shows the Cross Comp Tool window and the Complementarities window. Complementarities are indicated by vertical lines. The bold lines indicate cross-complementarities of the minimum size or larger. In the example below, the window displays cross-complementarities between the Forward primer and Probe 2 (the button on row 1, column 4 is depressed).

You can move or resize the window, copy information from the window, or print the window.
To adjust the Complementarities window

- To resize the Complementarities window, click a side or corner of the window and drag it to the desired size.
- To move the Complementarities window, click in the window’s title bar, then drag the window to the desired location.
- To return the Complementarities window to its default size and location, click the icon \textbf{Reposition Below Parent} in the upper left corner of the Complementarities window, then select \textbf{Reposition Below Parent}.

To copy and paste or to print the Complementarities window

- To copy and paste information from the window into another program:
  - Highlight the information in the Complementarities window you want to copy, then press \textbf{Ctrl-C} to copy the information to the Clipboard.
  - Open the destination file in the other program, then paste the information using the paste command appropriate for that program.
  - To print the Complementarities window, resize the window so it displays the information you want to include, then press \textbf{Ctrl-P} or click the icon \textbf{Print Window} in the upper left corner of the Complementarities window, then select \textbf{Print Window}.

1.3.1 Viewing all cross-complementarities in one alignment

The \textbf{MultiMatch} feature of the Cross Comp Tool collapses the sequence pairs in the Complementarities window so that all the cross-complementarities in a particular alignment are shown together. This features makes it easy to see when a particular alignment generates many cross-complementarities.

To use MultiMatch

- In the \textbf{Cross Comp Tool} window, select the \textbf{MultiMatch} option.

The following illustration shows two oligos as they appear in the Complementarities window when MultiMatch is not selected. Notice that the pair of strands is repeated for each of the bold cross-complementarities, even though the strands are in the same alignment.

<table>
<thead>
<tr>
<th>Min 3’ Length</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min All Length</td>
<td>4</td>
</tr>
<tr>
<td>Multi Match</td>
<td>\checkmark</td>
</tr>
<tr>
<td>Show Delta G</td>
<td>\xmark</td>
</tr>
</tbody>
</table>

2 Complementarities - Oligo 1 : Oligo 1

5’-AAGGTCCGTCACCAAGACGTGATCTGAATTTCACCP-3’ \( \Delta \delta = -2411 \)
3’-GCTATTTAGATCGTAAGACACGATATACAGC-5’

5’-AAGGTCCGTCACCAAGACGTGATCTGAATTTCACCP-3’ \( \Delta \delta = -2411 \)
3’-GCTATTTAGATCGTAAGACACGATATACAGC-5’
Performing Advanced Tasks

The following illustration shows the same oligos when MultiMatch is selected. The strands in the same alignment have been collapsed into one pair, with all the cross-complementarities shown between the strands.

1 Complementarity - Oligo 1

5' - AAGCTGGTCAAGCAGAATAGTTTATTTTACC5'  ΔG = -48.22
3' - CCCTTCTGTAATATAGATACCTCCGAGA-3'

Affect of MultiMatch on scoring

If you use cross-complementarity size to score the complementarities (instead of using Delta G), then the MultiMatch feature may cause the labels on the detail buttons in the 3' set to change. If MultiMatch is selected, those oligos that have 3' cross-complementarities are further analyzed for additional cross-complementarities of any kind. If any of these additional cross-complementarities are as large as or larger than the 3' cross-complementarities, then the labels on the associated buttons change to reflect the new size of the largest cross-complementarities.

When MultiMatch is selected, the total number of cross-complementarities listed at the top of the detail box may also change. This number changes to reflect the number of alignments that have cross-complementarities, instead of the number of cross-complementarities of the minimum size.

1.4 Saving, printing, closing, and reopening a cross-complementarity analysis

You can save a cross-complementarity analysis and reopen it later. You can also print an analysis window or a report of an analysis.

To save an analysis

1. Perform the cross-complementarity analysis.

2. From the Cross Comp Tool File menu, select Save As.
   The default file name for the analysis is the genome name. The default location to save the analysis is the Oligo directory in your LC PDS 2.0 software installation path.

3. Accept the default name and location or enter a new name and select a new location, then click Save.

The file is saved with an .olg extension.

To print an analysis window

1. Display the window you want to print.

2. Press Ctrl-P.

To print an analysis report

1. Complete the Cross-Complementarity analysis.

2. From the Cross Comp Tool File menu, select Print Report.
Analyzing a design for cross-complementarities

Adding, deleting, and changing oligos in an analysis

To close the Cross Comp Tool

1. From the File menu, select Exit, or click the X in the upper right corner of the window.

To reopen a saved cross-complementarity analysis

1. From the LC PDS 2.0 Tools menu, select Cross Comp Tool.
   - If you have previously used the Cross Comp Tool during this software session, when you open the Tool, the previous cross-complementarity analysis is displayed.
2. From the Tool's File menu, select Open.
3. Find and select the .olg file for the analysis you want to view, then click Open.
4. View or edit the analysis as needed.
5. From the File menu, select Save.

1.5 Adding, deleting, and changing oligos in an analysis

You can add, delete, or edit individual oligos displayed in the Cross Comp Tool.

To add a new oligo to the analysis

1. In the Cross Comp Tool, click Add.
   - An Edit Sequence dialog box opens.
2. In the Name box, enter the name of the oligo (Forward, Reverse, Probe 1, or Probe 2 or any name you choose).
3. In the Sequence box, type or paste the sequence.
4. If this is a primer, select Is Primer.
5. If the oligo is a probe, but you want to place the probe on the opposite strand, select Complement Strand.
6. Click OK.

The new oligo is added to the Cross Comp Tool window.
Performing Advanced Tasks

Analyzing a design for cross-complementarities

Adding, deleting, and changing oligos in an analysis

To add a design to a previously saved analysis

After you design one set of primers and probes, you can add the selected design to a previously saved cross-complementarity analysis to view cross-complementarities between the two designs. For example, you might want to do this if you are planning to use the two sets of primers and probes in a multiplex reaction.

1. Design the first primer probe set, then perform a cross-complementarity analysis on the set and save the results.

2. Design the next primer probe set (the set you want to analyze for cross-complementarities with the first set); leave the LC PDS 2.0 Primer Probe Sets tab selected.

3. Open the Cross Comp Tool.

4. From the File menu, select Open.

5. Find and select the previously saved cross-complementarity analysis, then click Open. The saved analysis is displayed in the Cross Comp Tool.

6. Close the Cross Comp Tool.

   Even though the tool is closed, it “remembers” the analysis that was just displayed.

7. On the Primer Probe Sets tab, select the primer probe design you want to analyze with the previously saved cross-comp analysis.

8. From the Tools menu, select Cross Comp Tool – Add Current Selection.

   The Cross Comp Tool opens, displaying the previously saved analysis (because it was the last analysis displayed) and also the primer and probe design currently selected on the Primer Probe Sets tab.

9. View the cross-complementarities among the oligos, as described in the previous sections.

To delete a primer or probe

1. In the Cross Comp Tool, deselect the check box next to an oligo to remove it from the current analysis of cross-complementarities.

   – Or –

   To remove the oligo from the Cross-Comp Tool completely, click Delete. The oligo is deleted from the tool window.

To edit a sequence

1. In the Cross Comp Tool, select the oligo you want to change, then click Edit.

   The Edit Sequence dialog box opens, containing the oligo sequence.

2. Change values as necessary.

   If the sequence was imported from the Primer Probe Sets tab of the Probe Design window, you can edit only the sequence name.

3. Click OK.

   The changes are applied to the oligo in the Cross Comp Tool window, so you can analyze the modified sequence for cross-complementarities.

After you edit an oligo sequence, a tilde (~) is displayed in front of the calculated Tm to indicate that the melting temperature is now an estimate. The software cannot determine the exact melting temperature of an edited oligo sequence.
2. Designing primers and probes for a multiplex reaction

A multiplex reaction is one in which multiple DNA sequences are analyzed in the same capillary tube. You can design oligos for two kinds of multiplex reactions:

- A standard multiplex reaction. In this case, you must design primers and probes for each DNA target and then label each probe with a different dye, which will be measured in different fluorimeter channel in the PCR instrument. After amplification, the presence of a DNA product is indicated by the presence of an amplification curve in that product’s fluorescence channel. With LC PDS 2.0 you can design primer and probes for up to 4 different DNA targets with 4 different color dyes (610, 640, 670 and 705 nm) in only one reaction.

- An amplicon multiplexing reaction. In this case, you design only the primers needed to amplify each DNA target. Sybr Green I is used to indicate the presence of DNA. The DNA targets must have distinctly different melting temperatures. The amplification reaction is followed by a melt; the presence of DNA product is indicated by the presence of different melting temperatures in the fluorescence data.

2.1 Overview of design steps

To design primers and probes for a multiplex reaction, you must perform the following general steps. The steps are described in detail in the rest of this section.

1. Import each target DNA sequence to be used in the multiplex reaction.

2. Specify design parameters for each DNA target.
   
   It is recommended to use the LightCycler Multiplex DNA Master HybProbe for best performance.

3. Perform the initial search.

4. Refine the search.
2.2 Importing sequences

Only the sequences to be used in the multiplex reaction must be loaded into the software window. Delete any sequences that are not to be included in the multiplex reaction.

To import multiple sequences

1. To delete a sequence that is not used in the multiplex reaction:
   - Select the Design tab containing the sequence name, then from the Sequence menu, select Delete.
     - You are prompted to confirm the deletion.
   - Click OK.

2. Enter or import a sequence for the multiplex reaction. For instructions, see the section “Entering a DNA sequence,” in Chapter C, above.

3. If a sequence is already open in the software, you are asked whether you want to replace the existing sequence. Click No.

4. Repeat Steps 2 and 3 to add additional sequences.
   - Be sure each Design tab contains a sequence. Do not leave any empty tabs in the window, because the software includes the empty tabs when it searches the sequences, causing an error.

2.3 Specifying design parameters

You must specify the same design parameters for a multiplex reaction as you do for a non-multiplex reaction.

To specify design parameters

1. Select the Sequence tab for the first sequence included in the multiplex reaction.

2. Specify values in the Experiment Type, Sequence Information, and Experiment Settings areas of the tab as you would for any non-multiplex reaction.
   - For more information about all the settings, see “Specifying design parameters,” in Chapter B.

3. Repeat Steps 1 and 2 for each remaining sequence in the reaction.
   - For a standard multiplex reaction, you must either specify different dye types for each sequence, or you must specify probe melting temperatures that are at least 5°C apart. The melting temperatures of probes with dyes of adjacent wavelength should differ at least 2°C. Otherwise the software displays an error.
   - For an amplicon multiplexing design, you must specify Amplicon Multiplexing for each sequence.
2.4 Performing the initial multiplex search

To perform the initial search and view results

1. On the Sequence tab for the first sequence included in the reaction, click Analyze.
   The Analysis tab opens.

2. On the Analysis tab, define the search region for primer and probe sites. Do not click Single Set Search.

3. Repeat Steps 1 and 2 for each remaining sequence in the reaction.

4. After all search regions are defined, from the Tools menu, select Multiplex Initial Search.
   Status messages report the progress of the search.
   If you clicked Single Set Search on the Analysis tab for any of the sequences, a message asks whether you want to delete the single set searches. Click Yes to continue the multiplex search.

5. View results on the Multiplex Sets tab.
   Results are ordered from highest (best) to lowest.

6. To view details of a set, select the set from the result list.
   Details are displayed in the pane below the list. The type of information displayed on the window is identical to that displayed for a non-multiplex reaction. For more information, see “Viewing and saving results” in Chapter C.

2.5 Adding new sequences to an existing multiplex search

You cannot import additional sequences to an existing multiplex search (for example to increase from 2-x to 3-x multiplexing). To do this, start with a new design, import the previously saved *.spd file first (two sequences) and then import the sequence you want to be included for the 3x-plexing.
2.6 Refining the search

After you complete an initial search for multiplex oligos, you can perform a refined search that searches the bases on either side of the primers in a selected design.

To perform a refined search

1. On the Multiplex Sets tab, select the primer probe set you want to use as the basis for the refined search.
   
   You may want to perform a cross-complementarity analysis to help you choose a set. For more information, see “Analyzing a design for cross-complementarities” in Chapter D.

2. From the Tools menu, select Multiplex Refined Search.

3. View results on the Multiplex Sets tab.

3. Specifying experiment and reaction settings

You can change the experiment settings and reaction conditions for the current analysis, or you can change the default settings that are applied automatically when you import or enter a new sequence. When you specify default settings, you can specify defaults for each type of experiment (Quantification, Mutation Detection, and so on).

To change settings for the current analysis

1. From the Settings menu, select Current Settings.
   
   The Settings dialog box opens. The values reflect the settings from the main Probe Design window and apply only to the current analysis.

2. Modify the values on each tab as needed.

3. When finished, click OK.

To change default settings

1. From the Settings menu, select Default Settings.
   
   The Default Settings dialog box opens. The options you set here become defaults that are applied whenever you enter or import a new sequence.

2. Select an experiment type (Quantification, Mutation Detection, Primers Only, or Amplicon Multiplexing).
   
   Additional fields are displayed, depending on your selection.

3. Set the values you want for the currently selected experiment type.

4. Repeat Steps 2 and 3 to specify default values for the other experiment types.
To set default reaction conditions for all experiment types, select the **Reaction Conditions** tab, then select, add, or edit reaction conditions, as follows:

To edit a magnesium concentration of an existing buffer, select the buffer name, click **Edit**, modify the magnesium concentration, then click **OK**. The modified buffer is added to the list as an additional buffer.

To create a new buffer, click **Add**, enter information to define the new type, then click **OK**.

To delete a buffer you have added, select the desired buffer, then click **Delete**.

💡 You cannot delete Roche Standard buffer.

When you are satisfied with all the default experiment settings and reaction conditions, click **OK**.
<table>
<thead>
<tr>
<th>Appendix</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. <strong>Uninstalling LC PDS 2.0 under Windows XP professional</strong></td>
<td>83</td>
</tr>
<tr>
<td>2. <strong>Optimizing Primer Probe Sets designed with the LightCycler 2.0</strong></td>
<td>84</td>
</tr>
<tr>
<td>3. <strong>Recommendation for applying asymmetric PCR</strong></td>
<td>86</td>
</tr>
<tr>
<td>4. <strong>Troubleshooting</strong></td>
<td>87</td>
</tr>
<tr>
<td>5. <strong>Overview of file formats</strong></td>
<td>89</td>
</tr>
<tr>
<td>6. <strong>Literature</strong></td>
<td>90</td>
</tr>
<tr>
<td>7. <strong>Copyright notice and disclaimers</strong></td>
<td>91</td>
</tr>
<tr>
<td>8. <strong>Trademarks</strong></td>
<td>94</td>
</tr>
</tbody>
</table>
Appendix

1. **Uninstalling LC PDS 2.0 under Windows XP professional**

It is recommended to remove existing versions of LC PDS before installing future versions. Removing the previous version of the software does not delete any existing primer probe designs such as *.spd and *.old files.

**To uninstall a previous version of the software**

1. Insert the new [LightCycler Probe Design Software 2.0 CD](#) in the CD-ROM drive. If a previous version of the software is installed, the following window opens.

   ![InstallShield Wizard](image)

If the window above is not displayed, then a previous version of the software is not installed on your computer. To install the new software, follow the procedure, "Installing the new software version" in Chapter A.

2. Select **Remove**, then click **Next**.
   A message asks you to confirm removing the application and all its components.

3. Click **OK**.
   The software is removed, then a Maintenance Complete window opens.

4. Click **Finish**.
2. Optimizing Primer Probe Sets designed with the LC PDS 2.0

LC-PDS 2.0 greatly simplifies the design of LightCycler Probe reactions. For multiplexing assays it has been evaluated that it is possible just to start with the multiplex reaction. Pre-testing with monoplex assays is not longer a need. But PCR is a complex process and for any given experiment only some of the important factors can be known. In practice this means that once primer probe sets have been designed with the software, it is strongly advised that a simple protocol be run to find the most robust conditions for the reaction.

Traditionally, a single bright band on an agarose gel is a good indicator of an optimized PCR reaction. On the LightCycler, cycle threshold (crossing point) values as well as end-point fluorescence levels define an optimized reaction. A more efficient reaction will have a lower cycle threshold value and higher end-point fluorescence.

Optimization of LightCycler reactions requires only a few steps that are described below. There are four critical variables to optimize:

➔ The Annealing Temperature

In every PCR reaction there is a competition for hybridization between the primers and the complementary target strand. Early in the reactions the primers are helped by mass action, as they are far more concentrated than the target strands. But as the reaction continues this advantage is diminished.

The maximum rate of primer annealing occurs at about 5°C below the $T_m$ of the primer. This is the temperature where the primer should compete most successfully with the product and is the best place to start when optimizing the reaction.

The $T_m$ can be found on the LCPD report. The best guess annealing temperature is determined by subtracting 5 degrees from the melting temperature of the lowest melting primer. Begin with a 10 second annealing time.

Example: For a primer set with $T_m$ 's of 61°C and 60°C, the best guess annealing temperature is 55°C.

➔ The Product Extension Time

The extension temperature should almost always be 72°C; this is the optimal temperature for Taq DNA polymerase. At this temperature Taq polymerase will add about 100 nucleotides per second. A safe extension time (in seconds) can be determined by dividing the product length by 25. The length of your product can also be found on the primer/probe report sheet.

Example: For a 377 base pair product Extension Time = 400/25 = 16 seconds.

➔ The Denaturation time

When using the LightCycler FastStart DNA Master HybProbe and the LightCycler Multiplex DNA Master HybProbe, a 10-minute hold should precede the cycling protocol with a 10 second hold at the denaturation step of each cycle. This is required to activate the polymerase.
Magnesium concentration is important in the PCR reaction for two reasons: First, magnesium stabilizes DNA duplexes, and second the magnesium aids the enzymatic activity of Taq polymerase.

The magnesium concentration used in probe design by LC PDS 2.0 will often be the optimal concentration. However, since magnesium is so important to the reaction, it is recommended to run the best guess conditions discussed above with 2, 3, 4 and 5 mM (final) magnesium to determine the optimum concentration.

If the magnesium concentration is too high the reaction will not be stringent enough. Primer dimers and other non-specific products will form. If magnesium is too low, the reaction will not perform as well because the primers will not bind efficiently to the template strands. At extremely low magnesium the deoxynucleotides will bind up all the magnesium and the enzyme will not be able to perform at its best. By the same token if the annealing temperature is too low, it creates an environment suitable for primer dimers. If the annealing temperature is too high it is too stringent, even for perfectly matched primers to anneal.

The figure (see above) gives an overview of the input of magnesium concentration and annealing temperature on stringency.
3. **Recommendation for applying asymmetric PCR**

An additional method that may lead to the improvement of certain reactions is asymmetric amplification. Using an asymmetric primer ratio results in preferential amplification of one strand. If the favoured strand is the one that binds to the probes, asymmetric amplification can lead to an improvement of the fluorescence signal, especially for long amplicons.

**Quantification**

Asymmetric amplification may help reduce the decline in the fluorescent plateau (hook effect) that is sometimes seen with HybProbe Probes. Depending on base composition and length of an amplicon its strands may tend to anneal faster than the HybProbe Probes have the opportunity to bind to their target sites. This is also avoided by favouring the production of one strand. The drawback of asymmetric amplification is a reduced PCR efficiency because the reaction shifts from exponential to linear amplification as one of the primers becomes limiting.

If no fluorescent signal is obtained in the PCR reaction containing HybProbe Probes, and one is confident that the primers are successfully amplifying DNA, the problem might be caused by competition between probe-target hybridization and target-target hybridization that results in out-competition of the probes by the complementary strand of the target DNA. This can be overcome by skewing the primer concentration in the reaction to favor the formation of the DNA strand that the probes bind to.

**In this case, the concentration of the primer that produces the strand complementary to the probes is raised 2 to 5 fold (up to 50 fold for SimpleProbe Probes) over the other primer. No other reaction conditions should be changed.**

This simple change can sometimes transform what appears to be a failure of the reaction into a well-defined amplification.

**Melting Curve Analysis**

Using asymmetric PCR, fluorescence signals and melting peaks can be improved.
4. Troubleshooting

Overlapping oligos

For very small amplicon sizes and for mutation positions at the very ends of sequences it may occur that sequences for primers and probes overlap. If so, a notification field indicating a warning will be displayed in the results TAB and Print Report.

⚠️ Warning: Oligos in this Set Overlap

If possible you should avoid those sets. If inescapable try to enlarge the search area of the sequence. A different approach could be: Select only the sets with minimal overlap for the same strand and avoid primer probe overlappings on different strands that may lead to primer extension.

Fixed Oligos

Differences in $T_m$

If you use tested existing oligos (fixed Oligos) and get a bad score during the analysis, check whether the $T_m$'s you defined in the settings and the $T_m$'s of the fixed oligos match closely. If not, the chance is high that this is the cause for the bad score.

This applies also for comparison studies with previous Software versions such as LC PDS version 1.0 and LC PDS 2.0.

Delta G

The delta G value allows better interpretation of cross-complementarities. Besides counting the numbers of complementary bases, it discriminates between weak and strong binding of TA or GC.

The following example compares four bp overlaps of primers with high stability (GC), medium and lower stability (AT)

3' Complementarity - strong binding:

5'-'AAAAGCC-3'  \( \Delta G = -4411 \)


3' Complementarity - medium binding:

5'-'AAAGATC-3'  \( \Delta G = -2011 \)


3' Complementarity - weak binding:

5'-'AAATTAA-3'  \( \Delta G = -1112 \)


Delta G’s less than -3000 should be avoided.
**Optimizing designs**

If you get high yield of amplicon by gel analysis but suboptimal signal / $T_m$ peak you might improve the performance by starting a new design for the same primers and switch the probe binding site to the complementary strand.

**Adding new sequences to an existing multiplex search**

You cannot import additional sequences to an existing multiplex search (for example to increase from 2-x to 3-x multiplexing). To do this, start with a new design, import the previously saved *.spd file first (two sequences) and then import the sequence you want to be included for the 3x-plexing.

**Scores**

The principle of scoring is to add penalties (negative points). As every suboptimal motif in the sequence gets penalized the scores get more negative. The best oligo score that can be reached is “zero”.

**Sequence names / Print Report**

Please avoid potential errors during creation of Print Reports by using letters only for sequence names.

Not allowed are „ / \ : < * ? | “

Troubleshooting
5. **Overview of file formats**

This table explains file extensions used in the LC PDS versions 1.0 and 2.0.

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.spd</td>
<td>Result of a design with LC PDS 2.0.</td>
</tr>
<tr>
<td>*.lpd</td>
<td>Result of a design with LC PDS 1.0. If you import a *.lpd file under LC PDS 2.0 only the sequence information is present.</td>
</tr>
<tr>
<td>*.old</td>
<td>Designs saved as *.spd files (LC PDS 2.0) such as Sequence, Analysis or Primer Probe Sets (created during the design process with identical design file names) are being saved as *.old files in the 'Archive' Folder (renamed *.spd files). The second part of the *.old file name indicates the time of creation. This information is helpful to follow up on the history of designs. Only the last created design will be stored as an *.spd file.</td>
</tr>
<tr>
<td>*.txt</td>
<td>Text file formats of Sequences. Please use the command 'Import' in the Sequence menu for sequences generated in GenBank, EMBL and FASTA formats.</td>
</tr>
<tr>
<td>*.olg</td>
<td>Result of a cross-complementarity analysis.</td>
</tr>
<tr>
<td>*.XML</td>
<td>Flexible format to exchange information of primer probes sequences for future order options via Internet.</td>
</tr>
</tbody>
</table>
6. Literature


7. Copyright notice and disclaimers

LightCycler Probe Design Software 2.0

NOTICE TO USER: THIS IS A BINDING CONTRACT. PLEASE READ IT CAREFULLY. BY INSTALLING, READING INTO MEMORY OR EXECUTING THIS SOFTWARE, YOU ACCEPT AND AGREE TO BE BOUND BY THESE TERMS AND CONDITIONS.

For purposes of these Terms and Conditions, the term “You” refers, individually and collectively, to (1) the individual user who installs, reads into memory and/or executes this Software and (2) if such individual user is employed by or a representative or agent of a legal entity, such legal entity. You hereby covenant and agree with, and for the benefit of, Roche Diagnostic GmbH, Mannheim (“RDG”), as follows:

§ 1 Ownership of the Software

1.1 This SOFTWARE and the accompanying written materials are owned by Idaho Technology, Inc., an Idaho corporation (“IT”), and exclusively licensed by IT to RDG. The Software is protected by copyright laws and international copyright treaties, as well as other intellectual property laws and treaties. Except for the rights expressly provided by these Terms and Conditions, You stipulate and agree that neither RDG nor IT grants by implication, estoppel, or otherwise, any rights or licenses in, to or under the Software or any related proprietary rights under applicable patent, trade secret, copyright or other laws, rules or regulations.

§ 2 Grant Of License

2.1 RDG grants You the non-exclusive, royalty-free, worldwide right and license to (a) install and use one copy of the SOFTWARE on a single computer system or (b) in the case of a multi-user or networked system which permits access to the SOFTWARE by more than person at the same time, install and use the SOFTWARE on a single network file server or other storage device, provided that You have obtained a License for Network Station from RDG for the number of stations or computer terminals which may access or execute the SOFTWARE from such file server or other storage device (the “LICENSE”).

2.2 The LICENSE does not permit You to copy the SOFTWARE, except that You may make one copy of the SOFTWARE in machine readable form solely for backup purposes, provided you reproduce the copyright notice(s) and any proprietary legends. You may not copy the written materials which accompany the SOFTWARE.

§ 3 Restrictions on Use and Transfer

3.1 You may not distribute the reports generated by the SOFTWARE in exchange for any compensation, revenue or any other material exchange without express written permission from RDG, which shall be granted at the sole discretion of RDG, subject to a mutually amicable business arrangement between RDG and you.

3.2 You shall maintain the SOFTWARE and all proprietary rights as confidential and proprietary with at least the same degree of care that You use to protect your own confidential and proprietary information, but no less than a reasonable degree of care under the circumstances. You shall take all steps necessary to ensure that all persons having access through it to the SOFTWARE agree to, and observe and perform, the provisions of these Terms and Conditions.
3.3 You may permanently transfer your original copy of the SOFTWARE and accompanying written materials (including the most recent update and all prior versions) provided (1) You retain no copies and (2) the transferee receives these Terms and Conditions AND agrees in writing to be bound by its terms. Such a transfer terminates the LICENSE as to You and substitutes the transferee in your place.

3.4 You may not sell, transfer, assign, lease, loan, rent, sublicense, reproduce, duplicate or distribute the SOFTWARE in whole or in part; except as stated in the preceding paragraph. The SOFTWARE contains trade secrets and in order to protect them, you may not decompile, reverse engineer, disassemble, or otherwise reduce the SOFTWARE to its source code or other preferred human-perceivable form. YOU MAY NOT MODIFY, ADAPT, TRANSLATE, RESELL FOR PROFIT, DISTRIBUTE, NETWORK OR CREATE DERIVATIVE WORKS BASED UPON THE SOFTWARE OR ANY PART THEREOF.

§ 4 Limited Warranty

4.1 THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY WARRANTIES OF ANY KIND OR NATURE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE IS BORNE BY YOU. ANY AND ALL EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, INTEROPERABILITY, AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. NO ORAL OR WRITTEN OR ADVICE GIVEN BY THE COMPANY, ITS AGENTS OR EMPLOYEES SHALL CREATE ANY WARRANTY.

4.2 IN NO EVENT SHALL RDG OR IT BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION), HOWEVER CAUSED AND REGARDLESS OF THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, TORT (INCLUDING NEGLIGENCE) OR OTHERWISE ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

4.3 ANY LIABILITY OF RDG OR IT ARISING FROM OR RELATED TO THE USE, POSSESSION OR OPERATION OF THE SOFTWARE IS EXPRESSLY LIMITED TO THE GREATER OF (a) THE MONETARY FEES PAID BY YOU TO RDG FOR THE SOFTWARE OR (b) U.S. $100.00. YOUR SOLE REMEDY IN ANY DISPUTE REGARDING THE SOFTWARE UNDER THESE TERMS AND CONDITIONS SHALL BE TO SEEK RECOVERY OF SUCH AMOUNTS, UPON THE PAYMENT OF WHICH RDG AND IT SHALL BE AUTOMATICALLY RELEASED FROM AND DISCHARGED OF ALL FURTHER OBLIGATIONS AND LIABILITY TO YOU.

4.5 The remedies provided in this Section 4 shall be your sole and exclusive available remedy(ies) and you stipulate and agree that the exclusive remedy(ies) herein provided fully satisfy their essential and intended purposes (more particularly, you stipulate and agree that the exclusive remedy(ies) provided herein will, despite the difficulties inherent in determining actual damages which you might incur or suffer in the future, provide legally adequate monetary and other compensation to you).

§ 5 Miscellaneous Provisions

5.1 The failure of either party to take any action under these Terms and Conditions, or the waiver of a breach of these Terms and Conditions, shall not affect that party's rights to require performance hereunder or constitute a waiver of any subsequent breach. A waiver to be valid shall be in writing, but need not be supported by consideration.
5.2 These Terms and Conditions may not be altered, modified, amended or changed, in whole or in part, except by a writing executed by the parties.

5.3 These Terms and Conditions shall be governed by the laws of the State of California, without regard to its conflicts of laws principles, and by the U.S. Copyright Act of 1976, as amended. These Terms and Conditions will not be governed by the United Nations Convention on Contracts for the International Sale of Goods, the application of which is expressly excluded.

5.4 These Terms and Conditions shall be fairly interpreted in accordance with its terms without any strict construction in favor of or against either party, and ambiguities shall not be interpreted against the drafting party. In interpreting these Terms and Conditions, the word "or" shall not be construed as exclusive, and the word "including" shall not be construed as limiting. The headings herein are for reference only and shall not define or limit the provisions hereof.

5.5 You acknowledge and agree that these Terms and Conditions constitutes the entire agreement between You and the Company with respect to the Software and proprietary information, and all prior or contemporaneous agreements, whether written or oral, as may relate to the Software or its related proprietary information, are hereby superseded by these Terms and Conditions.

5.6 If any provision of these Terms and Conditions is found to be invalid or unenforceable by a court or tribunal, whether due to particular time limits, unreasonableness or otherwise, it is agreed that the provision in question shall be reduced or otherwise modified by such court or tribunal, but only to the extent necessary to permit its enforcement and only in such court's jurisdiction. If the particular provision cannot be reduced or modified to make it enforceable, that provision shall then be severed from these Terms and Conditions and the remaining provisions of these Terms and Conditions shall remain in full force and effect giving maximum validity and enforceability to these Terms and Conditions.

5.7 These Terms and Conditions shall be binding upon the parties and their successors, assigns, transferees, grantees, executors and administrators. Although IT has licensed the Software to RDG for further distribution, neither IT nor RDG is a partner, joint venturer or agent of the other. However, You and RDG specifically intend that IT is, and shall be, a third party beneficiary of these Terms and Conditions.

5.8 If You are located outside the U.S., You are responsible for complying with any local laws in its jurisdiction which might impact its right to import, export or use the Software, and You represent that You has complied with any regulations or registration procedures required by applicable law to make this license enforceable.

USER ACCEPTS AND AGREES TO BE BOUND BY THESE TERMS AND CONDITIONS.
8. Trademarks

LightCycler, SimpleProbe, HybProbe are trademarks owned by a member of the Roche Group.

SYBR is a registered trademark of Molecular Probes Inc.

Windows XP and Windows 2000 are registered trademarks of Microsoft Corporation.